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The MaxProLogic is an FPGA development board that is designed to be user friendly and a great
introduction into digital design for Electrical Engineering students and hobbyists. This board
provides innovative methods of developing and debugging programmable logic code. It has been
designed from the ground up to provide the functionality needed for the demanding projects from
today’s students and hobbyists. The board provides a convenient, user-friendly workflow by
connecting seamlessly with Altera’s Quartus Prime Lite software. The user will develop the code
in the Quartus environment on a Windows Personal Computer. The programmable logic code is
loaded into the FPGA using only the Quartus Programmer tool.

The core of the MaxProLogic is the Altera MAX10 FPGA. This powerful chip has 4,000 Logic
Elements and 200 Kbits of Memory. The MAXI10 is easily scalable from the entry level college
student to the most advanced projects like an audio sound meter with FFT. The MAX10 is in
Altera’s line up of low cost, multi-function FPGA’s.

Circuit designs, software and documentation are copyright © 2025, Earth People Technology,
Inc

Microsoft and Windows are both registered trademarks of Microsoft Corporation. Altera is a
trademark of the Altera Corporation. All other trademarks referenced herein are the property of
their respective owners and no trademark rights to the same are claimed.
http://www.earthpeopletechnology.com/
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o Please Note: The MaxProLogic Does Not Contain On Board
Programmer. JTAG Programming and Configuration Flash
Programming must be performed by external Programmer Purchased

Separately.

1 Introduction
The MaxProLogic is an FPGA development board. It requires an external programmer to load
user code into the flash of the FPGA. The core of the board is the MAX10 chip. It has a built in
Flash for configuration and incorporates 8 channels of Analog to Digital Conversion. The board
has two power options

e Standard USB-C connector

e 5.5mm Barrel connector
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The MaxProLogic can be powered from a laptop with 2.5W of power. Or it can be run it from
the +5V @ 2A wall USB chargers for 10W of power. The barrel connector can handle up to
+5.5V @ 3 A for 16.5W of power. The MaxProLogic has a MicroSD connector on the bottom of
the board. The board has an optional On/Off pushbutton switch that allows the user to turn the
system on and off. The clocking comes from a S0MHz oscillator.

2 User Setup

The MaxProLogic is ready to go straight out of the box. Just connect power from either a
PC/Laptop, +5 VDC Universal Wall Charger, +5 to 5.5 VDC through barrel connector. Install
the On/Off jumper to select default mode or On/Off switch. See the Power Section for details on
powering the board. Next, connect a JTAG Blaster or Altera USB Blaster to J13 for
programming the MAX10 chip. Then, write some code, synthesize, and program the chip. See
the Programming the MaxProLogic Section for details about programming the MaxProLogic
board. EPT provides a project DVD with source code, compiled code, user manual, data sheet
and schematics available for download on the EPT website.
https://earthpeopletechnology.com/products-page-2/modules/maxprologic

3 MaxProLogic Description

The MaxProLogic is designed to give the user lots of options to communicate with and test the
functionality of the MAX10 FPGA. Most of the FPGA Inputs/Outputs are available at board
connectors. All components are contained on one board. It operates with power either from the
USB connector or the Barrel Connector.
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3.1 Functional Block Diagram
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3.2 MAXPROLOGIC SPECIFICATIONS
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MAX 10 10M04SA FPGA From Altera 4,000 Logic Elements;

2.2 Mbit On chip Flash; 189 Kbit On Chip SRAM 8 Analog Input
Channels; 12 bit; 1MSamples/Second 65 Available I/O’s at connectors
65 Inputs/Outputs available at connectors on board
8 Green User configurable LEDs 1 Power Pushbutton Switch; 1 User Configurable Pushbutton Switch

On Board MicroSD Card Slot

Two Power options: Standard USB (+5V @ 2Amp) Using USB-C connector; Smm Barrel Connector

Accepts +5.5V @ 3Amp

Switching Power Supply, Provides stable output under high load stress
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On/Off controller uses push button, optional bypass mode to allow board power up without On/Off control
50MHz Oscillator
On board interface to Standard UART Serial Adapters

Standard Programming Connector fits any Altera USB Blaster

ON/OFF POWER
CONTROL

TEMPERATURE SENSOR

CONNECTOR 1/0 CONNECTORS

ON/OFF PUSH BUTTON 50MHZ OSCILLATOR

MAX10 FPGA

BARREL CONNECTOR ANALOG INPUT BUFFERS
FOR POWER

UART BREAKOUT BOARD

INTERFACE

8 GREEN LEDS 10M0O4SAE144C8G !

E BAGAZ22434

ll!!"‘!

USB C FOR POWER

L]
mnn

USER PUSH BUTTON

+3.3V POWER SUPPLY

1/0 CONNECTORS JTAG PROGRAMMING
CONNECTOR

3.3 FPGA
The MaxProLogic includes the Altera 10M04SAE144C8G FPGA. It is an EQFP 144 pin
package. This FPGA incorporates both the configuration flash and the ADC on the chip. This is
different from conventional FPGAs as these two items are usually off chip. Access to the
configuration flash is transparent to the user. The user does have access to the User Flash. This
access is provided through the Altera MegaFunctions at the project level. Access to the ADC is

also provided through the Altera MegaFunctions at the project level.
Parameter 10M04SA
LEs (Logic Elements) 4,000
Page
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Block memory (Kb) 189

User flash memory1 (KB) 16 — 156

18 x 18 multipliers 20

Phase-locked loops (PLLs) 2

Internal configuration Dual
Analog-to-digital converter 8 Channels, 1MSa/Sec
(ADC)

External memory interface Yes

(EMIF)

Inputs/Outputs 101

3.4 Power Supply
The MaxProLogic is designed to be operated from one of the following power sources:
e standard USB cable from Laptop/PC.
e +5 VDC through USB-C cable.
e +4.5to0+5.5 VDC supplied through the Barrel Connector.
This input provides power for a high-efficiency switching regulator on-board to provide +3.3
VDC. The DC power supply provides reliable power under dynamic loads and high frequency
switching internal to the FPGA. The core of the switching supply is the T1 TPS54229 chip.

Page




@ !EAR'I;HPEPPLE
g £ n o o g

MaxProLogic Development System User Manual

BARREL CONNECTOR
FOR POWER

EARTY
fTeci nurLw

IAIPIOIJ OIC-

l
n:', .

USB C CONNECTOR

+3.3V POWER SUPPLY

SV_IN

PWR_ENABLE —‘ 1’—{ 2
WBST 1 0.1uF

[ﬂm
m o=
< Z
2

o

ce7
0.1uF

10uF 1DuF

2 ||t

e

1 3
FllQ 0K
S i 1, 2
55 FB =0
a 4 787K
[}
=

‘\”_,:_i 1
“l 2 1
Hﬂ

Buck Switching Regulator

2 ||

—  CBo

10UF

The TPS54229 is a very stable synchronous buck converter. This allows it to provide a fast

transient response. You can view this response here:
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Wonrt = 50 _hr'\d W L
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t-Time - 100 us

1.05-, 50-mA to 2-A LOAD TRANSIENT
RESPOMSE

This switching supply can supply +3.3V up to 2.2 Amps. The current is limited by the 3.3uH
inductor. This is a part from Bourns, P/N: SRN4018-3R3M. The saturation current is 2.3 Amps
with a 2.2 Amp Irms. So, the supply has plenty of power for the FPGA and can supply power for
off board projects. Please consult the “Powering the MaxProLogic” section for determining
available output power per the input power. For example, running the input power from a
standard USB 2.0 limits the power to 2.5 Watts.

The TPS54229 has an Enable signal that allows the power supply to turn off. This signal is the
net PWR_ENABLE. It is controlled by the On/Off controller MAX16054 or default. The
operation of the On/Off controller is explained in section x. The default level for the
PWR_ENABLE is high. The default level allows the power supply to turn on when power is
applied to the board.

3.5 Clock Domain
The MaxProLogic provides an external clock domain to the MAX10 FPGA, 50 MHz. The 50

Page
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MAX 10 FPGA

50MHZ OSCILLATOR

—rav v pxwwwion] )
00000000000 [
- ——. 'Y

Cmax®io it
10MO4SAE144CaG '3
E BAGAZ22434 H

provides a high speed clock to the FPGA. It is a CMOS device that provides a stable 50 MHz at
+50 ppm. This clock can be used directly in the user code or use it as an input to one of the
PLL’s internal to the FPGA. It is intended that this clock will drive the logic of the user code. If a
different clock frequency is required in the user code, use the PLL scale up/down to produce the
desired clocking.

Page
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3vs
3V3 _
1 c17
o 0w
e 50MHZ Oscillator L
2 ug R26
4
L en vce 1
2 3 50MHZ_CL 27R
GND ouT
ASDMB-50MHz

c18

0.1uF
o~

GCLK

26

27

6 PB_SWITCH_1 Cl—%
L]

SD_DATG
SD_DATA

6 SD_CMD ;;
6 SD_CD/DATS =

XI07_6
X107_7

U4-10

10_2_26/CLKON/DIFFIO_RX
10_2_27/CLKOP/DIFFIO_RX_
10_2_28/CLKIN/DIFFIO_RX_
10_2_29/CLK1P/DIFFIO_RX_
10_6_88/CLK2P/DIFFIO_RX,_
10_6_89/CLK2N/DIFFIO_RX_
10_6_90/CLK3P/DIFFIO_RX_
10_6_91/CLK3N/DIFFIO_RX,
10_6_96/DPCLK3/DIFFIO_R!
10_6_98/DPCLK2/DIFFIO_R;

10_1B_17VREFB1NO
10_2_30/VREFB2NO
10_3_48/VREFB3NO
10_4_61/VREFB4NO
10_5_80/VREFB5NO
10_6_97/VREFBENO
10_7_112/VREFB7NO
10_8_123/VREFBEND

The 5S0MHz oscillator output is applied to pin 26 of U4 (MAX 10 FPGA) via a series resistor,

R26.

Parameter

Max

Overall Frequency Stability:

+50

Operating Temperature:

+70

Output Load:

25

Supply Current

16

3.6 Digital I/Os

The MaxProLogic has eight 10 pin headers that provide 64 digital Inputs and Outputs. All of the

I/O’s are +3.3 VDC only. All I/O’s connect directly from the FPGA to one of the ten pin

headers.

Page
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1 \ f——— A\ 10PINI/O
10PINI/O 8 BIT BUS.
CONNECTOR [\—22T8YS ————————/| CONNECTOR
10PINI/O [f—0u0 f—————— N\ 10PINI/O
CONNECTOR |\—22T8Ys —2BTBYS _JlcONNECTOR
ALTERA
FPGA y
10PINI/O [f—00 f————— N 10PINI/O
CONNECTOR |\—22r8Ys 10M04 —2BTBYS _Jl cONNECTOR
10PINI/O [A— N\ A\ 10pPINI/O
CONNECTOR [\—22T8Y \—22T8% A conNECTOR

All I/O’s are organized into separate banks of the FPGA. There are eight banks. These different
banks provide different output speed technologies. Programmable Open Drain The optional
open-drain output for each I/O pin is equivalent to an open collector output. If it is configured as
an open drain, the logic value of the output is either high-Z or logic low. Use an external resistor
to pull the signal to a logic high. Programmable Bus Hold Each I/O pin provides an optional bus-
hold feature that is active only after configuration. When the device enters user mode, the bus-
hold circuit captures the value that is present on the pin by the end of the configuration. The bus-
hold circuitry holds this pin state until the next input signal is present. Because of this, you do
not require an external pull-up or pull-down resistor to hold a signal level when the bus is tri-
stated. For each I/O pin, you can individually specify that the bus-hold circuitry pulls non-driven
pins away from the input threshold voltage—where noise can cause unintended high-frequency
switching. To prevent over-driving signals, the bus-hold circuitry drives the voltage level of the
I/O pin lower than the VCCIO level. If you enable the bus-hold feature, you cannot use the
programmable pull-up option. To configure the I/O pin for differential signals, disable the bus-
hold feature. Programmable Pull-Up Resistor Each 1/O pin provides an optional programmable
pull-up resistor during user mode. The pull-up resistor weakly holds the I/O to the VCCIO level.
If you enable the weak pull-up resistor, you cannot use the bus-hold feature. Programmable
Current Strength You can use the programmable current strength to mitigate the effects of high
signal attenuation that is caused by a long transmission line or a legacy backplane.

To provide maximum flexibility to system designers, all FPGA 1/O are intrinsically bidirectional.
Based on the I/O direction specified in the configuration file, each I/O can be configured as
input-only, output-only, or bidirectional. While the output buffer of a bidirectional I/O has
always included a dynamic output enable signal, MAX 10 FPGAs also include an input buffer
enable/disable capability. When an input buffer is dynamically disabled, the buffer presents its
last known state to the FPGA core fabric, so that no inputs inside the FPGA are left floating.

Page
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3.7 Analog Input
The MaxProLogic features an analog input of eight buffered channels. Each channel has its own
IMHz Unity Gain Amplifier to provide isolation and filtering. The Unity Gain Amplifier
provides the best isolation between channels when using a Sample and Hold ADC and a high
speed multiplexor.
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The Analog Inputs connect up to the MAX 10 FPGA using the following pins:
Connector RefDes- MaxProLogic FPGA Signal Name | MAX 10 Pin Number
Pin Number Schematic
Signal
J11-1 +5V NC
J11-2 ANALOG IN 1 USER_AINJO0] 6
J11-3 ANALOG IN 2 USER_AINJ1] 7
J11-4 ANALOG IN 3 USER_AINJ[2] 8
J11-5 ANALOG IN 4 USER_AINJ[3] 10
J11-6 ANALOG IN 5 USER_AINJ[4] 11
J11-7 ANALOG IN 6 USER_AINJ5] 12
J11-8 ANALOG IN 7 USER_AINJ6] 13
J11-9 ANALOG IN 8 USER_AINJ[7] 14
J11-10 GND NC
Page
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ANALOG INPUTS

The ADC provide the MAX 10 devices with built-in capability for on-die temperature
monitoring and external analog signal conversion. The ADC solution consists of hard IP blocks
in the MAX 10 device periphery and soft logic through the Altera Modular ADC IP core. The
ADC solution provides you with built-in capability to translate analog quantities to digital data
for information processing, computing, data transmission, and control systems. The basic
function is to provide a 12 bit digital representation of the analog signal being observed. The
ADC monitors up to 8 single-ended external inputs with a cumulative sampling rate of one
megasymbols per second (Msps).

Altera MAX 10 ADC Conversion

The ADC in dual supply Altera® MAX® 10 devices can measure from 0 V to 2.5 V. In single
supply Altera® MAX® 10 devices, it can measure up to 3.0 V or 3.3 V, depending on your
power supply voltage.

Page
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In prescaler mode, the analog input can measure up to 3.0 V in dual supply Altera® MAX® 10
devices and up to 3.6 V in single supply Altera® MAX® 10 devices.

The analog input scale has full scale code from 000h to FFFh. However, the measurement can
only display up to full scale — 1 LSB.

For the 12 bits corresponding value calculation, use unipolar straight binary coding scheme.

Output Code Full scale
A Transition “..
FFF =+ Y

FFE .
FFD T~ |_

) Full scale input =25V
-+ I Resolution = 212 =408
1156 =25V /4096 = &1035p"

12 bit Gutput Code [Hex)

Input Voltage (V)

The Altera® MAX® 10 ADC is a 1 MHz successive approximation register (SAR) ADC. If you
set up the PLL and Altera Modular ADC IP core correctly, the ADC operates at up to | MHz
during normal sampling and 50 kHz during temperature sensing.

Page
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PLL Clock In

Dedicated ADC Hard IP Block

#Analog Input J

- ﬁ DOUT[11:0]
ADCAnaloglnput | M Sampling ™~ 12bit 1 Mbps ADC

Sequencer [4:)]

[Dual Function] [16:1] | . and Hﬂ|d
i L Contral/Status
] o .
C Temperature Sensor J,
~ -~ | HiteraModular ADCIP Core

ADC Ve

Internal Vpgr

3.7.1 Voltage Representation Conversion
Use the following equations to convert the voltage between analog value and digital
representation.

Conversion from Analog Value to Digital Code
Digital Code=(vnvrer)x212Digital Code=(VINVREF)x212

Conversion from Digital Code to Analog Value
Analog Value=Digital Codex (vrer2:2)Analog Value=Digital Codex(VREF212)

3.7.2 Calculation Example for Vrer of 2.5V
Analog voltage value to digital code (in decimal), where signal in is 2 V:

Digital Code=(22.5)x4096=3277Digital Code=(22.5)x4096=3277
Digital code to analog voltage value, approximation to 4 decimal points:

Analog Value = 3277x(2.54096)=2.0000

3.7.3 ADC Analog Input Pins
The analog input pins support single-ended and unipolar measurements.
The ADC block in Altera® MAX® 10 devices contains two types of ADC analog input pins:

Page
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e Dedicated ADC analog input pin—pins with dedicated routing that ensures both
dedicated analog input pins in a dual ADC device has the same trace length.
e Dual function ADC analog input pin—pins that share the pad with GPIO pins.

If you use bank 1A for ADC, you cannot use the bank for GPIO.
Each analog input pin in the ADC block is protected by electrostatic discharge (ESD) cell.

3.7.4 ADC Prescaler

The ADC block in Altera® MAX® 10 devices contains a prescaler function.

The prescaler function divides the analog input voltage by half. Using this function, you can
measure analog input greater than 2.5 V. In prescaler mode, the analog input can handle up to 3
V input for the dual supply Altera® MAX® 10 devices and 3.6 V for the single

supply Altera® MAX® 10 devices.

P.DE 3|'5 kD

Analog —————"\N/\

Input .
36kQ=

Mu

REFGMD

The prescaler feature is available on these channels in each ADC block:
e Single ADC device—channels 8 and 16 (if available)

3.7.5 ADC Clock Sources

The ADC block uses the device PLL as the clock source. The ADC clock path is a dedicated
clock path. You cannot change this clock path.

For devices that support two PLLs, you can select which PLL to connect to the ADC. You can
configure the ADC blocks with one of the following schemes:
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o Both ADC blocks share the same clock source for synchronization.
e Both ADC blocks use different PLLs for redundancy.

If each ADC block in your design uses its own PLL, the Altera® Quartus® Prime Fitter
automatically selects the clock source scheme based on the PLL clock input source:

e Ifeach PLL that clocks its respective ADC block uses different PLL input clock source,
the Altera® Quartus®Prime Fitter follows your design (two PLLs).

o Ifboth PLLs that clock their respective ADC block uses the same PLL input clock
source, the Altera®Quartus® Prime Fitter merges both PLLs as one.

In dual ADC mode, both ADC instance must share the same ADC clock setting.

Related information
PLL Locations, Altera® MAX® 10 Clocking and PLL User Guide

3.7.6 ADC Voltage Reference

Each ADC block in Altera® MAX® 10 devices can independently use an internal or external
voltage reference. There is only one external VREF pin in each Altera® MAX® 10 device.
Therefore, if you want to assign external voltage reference for both ADC blocks in dual ADC
devices, share the same external voltage reference for both ADC blocks.

Altera recommends that you use a clean external voltage reference with a maximum resistance
of 100 Q for the ADC blocks. If the ADC block uses an internal voltage reference, the ADC
block is tied to its analog voltage and the conversion result is ratiometric.

3.7.7 Creating Altera MAX 10 ADC Design

To create your ADC design, you must customize and generate the ALTPLL and Altera
Modular ADC IP cores.

The ALTPLL IP core provides the clock for the Altera Modular ADC IP core.

Customize and generate the ALTPLL IP core.

Customize and generate the Altera Modular ADC IP core.
Connect the ALTPLL IP core to the Altera Modular ADC IP core.
Create ADC Avalon slave interface to start the ADC.

PN

Page

22


https://www.altera.com/content/altera-www/global/en_us/index/documentation/mcn1395213337540.html#mcn1395713558787

@ !EAR'I;HPElOPLE
B @ n o o g

MaxProLogic Development System User Manual

3.7.8 Parameters Settings for Generating ALTPLL IP Core

Navigate through the ALTPLL IP core parameter editor and specify the settings required
for your design. After you have specified all options as listed in the following table, you
can generate the HDL files and the optional simulation files.

For more information about all ALTPLL parameters, refer to the related information.

3.7.9 Completing ADC Design

The ADC design requires that the ALTPLL IP core clocks the Altera Modular ADC IP
core.

Generate the ALTPLL and Altera Modular ADC IP cores with the settings in the related
information.

Altera Modular ADC
dlock sample_store_irg
dodk_dk dk i sample_store_irg_irg
reset_sink
PLL . =
reset_sink_reset_n reset n
inclkd m ade_pll_clock
o inclkD frequency: 100,000 MHz ade_pll_dock_dk clk
Operation Mode: Narmal ade_pll_locked

0 locked ade_pll_locked_export export
ol 1710 | 0.00 SeqUencer_csr

sequencer_csr_address address
sequencer_csr_read read
sequencer_csr_write write
sequencer_ese_writedata[31..0] writedata
sequencer_csr_readdata[31..0] readdata

sample_store_csr
sample_store_csr_address[6..0] addrass
sample_store_csr_read read
\sample_store_csr_write write
sample_store_csr_writedata[31.0] |\yritadata
sample_store_csr_readdata31.0] |readdata

1. Create the design as shown in the preceding figure.
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2. Connect the c0 signal from the ALTPLL IP core to

the adc pll clock clk port of the Altera Modular ADCIP core.
3. Connect the 1ocked signal from the ALTPLL IP core to

the adc pll locked export port of the Altera Modular ADC IP core.
4. Create the ADC Avalon slave interface to start the ADC.

Parameter Setting

Parameter What is the frequency of the = Specify the input frequency to the PLL.
Settings > General/Modes | inclk0 input?

Parameter Create an 'areset' input to Turn off this option.
Settings > Inputs/Lock asynchronously reset the
PLL
Create 'locked' output Turn on this option. You need to connect

this signal to

the adc_pll locked port of
the Altera Modular ADC or Altera
Modular Dual ADC IP core.

Output Clocks > clk ¢0 Use this clock Turn on this option.
Enter output clock Specify an output frequency of 2, 10, 20,
frequency 40, or 80 MHz. You can specify any of

these frequencies. The ADC block runs at
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Parameter Setting

1 MHz internally but it contains a clock
divider that can further divide the clock
by a factor of 2, 10, 20, 40, and 80.

Use this same frequency value in

your Altera Modular ADC or Altera
Modular Dual ADC IP core. You need to
connect this signal to

the adc_pll clock port of the Altera
Modular ADC or Altera Modular Dual
ADC IP core.

Different ADC sampling rates support
different clock frequencies. For a valid
sampling rate and clock frequency
combination, refer to the related
information.

3.8 12C Sensor Connector
The MaxProLogic includes an [2C Sensor connector. This connector is designed to accept inline
six pin sensor boards that are popular with bread board connections.
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12C SENSOR
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The sensor is accessed through an I2C bus. This bus is connected to the FPGA through the

following pins:

Connector RefDes- MaxProLogic FPGA Signal Name | MAX 10 Pin Number
Pin Number Schematic
Signal
J14-1 +3.3V NC
J14-2 GND NC
J14-3 12C 0 SDA 12C _SDA 111
J14-4 12C 0 SCL 12C_SCL 110
J14-5 NC NC
J14-6 ND NC

The bus uses 2.7K pullups on both the SDA and SCK signals.
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3v3 3v3
2 2
g R6 R
27K 27K
1 1
6 12C_0 scL<___1
6 12C_0_SDA<__|
U4-8
T 1 110
U8 5 7771 10_7_110/DIFFIO_RX_T1P
X7 2 10_7_111/DIFFIO_RX_TIN
HEADER_100_MIL_1ox1 3 ROT 3 ”3 10_7_113/DIFFIO_RX_T4N
=—xo7 2775 10_7_114/DIFFIO_RX_T6P
5 X7 5 115 ] 10_7_118/DIFFIO_RX_T10P
i 10_7_119/DIFFIO_RX_T10N
B
10
—

1 MAX10 10MO4SAE144
These 12C signals can connect to any I12C device or Master. The user can implement code in the
FPGA will perform either Master or Device functionality. The MaxProLogic Project DVD
includes sample code to get the user started writing an 12C driver. This sample code is designed
to connect to the TMP102 Temperature Sensor Breakout Board.

This little board will connect up with J14 and is pin compatible.
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3.9 User LEDs
The MaxProLogic includes eight user LEDs. The LEDs are directly driven from the FPGA. User
code can implement any pattern on the LEDs by asserting a Ground to light up the diode and a
high to turn it off. The LEDs are located at the front of the board between the USB-C and Barrel

connectors.
0 " e e A A | D 3
e e - - 5
W5V w .1 4 : : - i f/guéuL'

USER LEDS

10MO4SAET44C8G !

iEvecNNOLoa!! ! E BAGAZ2243A

MNAXPROLOGIC 4
§E - 2 s:uu.m
ol} on

o rn Lmunnnmmmmxmmunu

l!l«vln llluaanll :

Page
28




@ !EAR'I;HPElOPLE
& B n o o g

MaxProLogic Development System User Manual

ALTERA
FPGA
10mMo04

it

LEDS

They use the +3.3V I/O’s along with a 220 Ohm series resistor for each LED. This provides the
following current through the LEDS

Vo =V
ligp = R
3.3V — 2.0V
ligp = —220
ILED == 59mA

The code to drive the LEDs is either zero (1°b0) or floating (1°bz). First, declare the LED as an
output. In the example below, the vector LED is set to ‘reg’ because it is driven in an always
block.
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Jmodule EPT_10M04 AF S2 Top |

inpunt wire CLE_10MHZ,

inpunt wire CLE_ 32KHZ,

inpunt wire EST,

ontput wire CLE_10MHZ ENAELE,
ontput wire CLE 32KHZ ENAREBLE,
ontput wire [7:0] XIC 1,

inpunt wire [7:0] XIo 2,

inpunt wire [7:0] XIC 3,

ontput wire [2:0] XIC 4,

input wire PWER_ENAELE,
ountput reg [7:0] LED

)y :

To turn the selected LED on, set the signal equal to 1°b0. This will apply a ground to the cathode
side of the LED and allow current to flow through the circuit turning the LED on. To turn the
selected LED off, set the signal equal to 1°bz. This will float the cathode side of the LED and no
current will flow through the LED.
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always @ (posedge CLE 10MHZ or negedge RST)
begin
if (1R5T)
LED <=
else
begin
if(state[LOAD LEDS])
begin
if ( led reg[C] }
LED[C] =
else
LED[C] =

if ( led reg[l] }
LED[1] =
else
LED[1] =

if ( led reg[Z] }
LED[Z2] =
else
LED[Z2] =

The User LEDs are available at the following pins:

LED Number MaxProLogic FPGA Signal Name | MAX 10 Pin Number
Schematic
Signal
D2 LEDI USER _LEDS[0] 21
D3 LED2 USER LEDSI[1] 22
D4 LED3 USER _LEDS[2] 24
D5 LED4 USER LEDSJ[3] 25
D10 LEDS USER LEDS[4] 32
D8 LED6 USER _LEDS[3] 33
D9 LED7 USER LEDS[6] 38
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| D7 | LEDS | USER LEDS[7] | 39

3.10 PushButton Switches
There are two pushbutton switches on the MaxProLogic. Both are momentary contact
switches. They include a 0.1uF cap to ground to debounce both switches. The User Push

Button Switch is configurable as input only to the MAX10. The user code can read the state
of the switch or use it as an event to trigger some action in the code.

Component Net Name Pin Number on Signal in EPT Project
MAX10 Pinout
SWI ON OFF CONTROL NA NA
SW2 PB SWITCH 1 27 PB SWITCH 1

SW2 is the User Configurable switch. It is assert low with a constant pullup to +3.3V. So, the
switch will read high until the button is pressed in which it will read low.

=]
5}

R23
10K

3 [ >PB_SWITCH_1 125

SW2

SW_TACTILE_MICRO
- - C74
0.1uF

1
o

e
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SW1 is configured as the Power Switch for the MaxProLogic. JMP2 selects whether the On/Off
Controller U1 is connected to the power system of the board. If the On/Off Controller
(MAX16054) is not connected to the circuit, the MaxProLogic will power on when power is
applied at the USB-C connector or barrel connector. If the On/Off Controller (MAX16054) is
connected to the power circuit, the power button

5V_IN

JMP2
JOMPER_100_MIL_3X1

—|eujen]

8 our >PWR_ENABLE 1,25
>

4
IN QUT_N =
3 _

SW1 -
SW_TACTILE_MICRO
=z
{ o O o
o MAX16054_SOT23-6
4 =

3 ON_OFF_CLEAR

CLEAR
[a]

On/0ff ConEroller

u2 5 IN
:

" '
L vee |2 5V_IN
E RST

uF 2 - 2
APX803_SOT23-3 ~ :
o~

Voltage Supervisor

—k o TALVC1G14SE-7

Inverter

3.11 SD Card Interface
The SD Connector uses a standard cell phone SD Card Connector. This connector has a
mechanism that opens out away from the board on a hinge and allows the card to be inserted into
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the hinged door. Close the hinged door and pull it towards the front of the MaxProLogic to

secure it.
SD CARD CONNECTOR

MOSAEAOLARLANMGA®RALSENMS
MLEQAASARRLNLAARAS ume
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F3

10

&

1

ST [ >SDDAT2 2

2|2 [-5D COVDATE 2

a2 [-SDCMD 2 e

4 4 T

5 : [ =sDClK 2

o Le

; .. =
7 [ =SDDATD T
.8 2 S0 DAT1 2
:g SD-CARD-CSHELL_SMD-12
SD Card Connector
The SD Card signals are available at the following pins:
SD Connector Pin MaxProLogic FPGA Signal Name | MAX 10 Pin Number
Number Schematic
Signal
P3-1 SD DAT2 SD DATAJ2] 60
P3-2 SD CD/DAT3 SD DATAJ3] 30
P3-3 SD CMD SD CMD 17
P3-4 +3.3V NC --
P3-5 SD CLK SD CLK 15
P3-6 GND NC --
P3-7 SD DATO SD DATAJ0] 48
P3-8 SD DATI SD DATA[1] 61
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3.11.1 SD Card Protocol

There's a ton of information out there on using the MMC/SD SPI protocol to access SD cards
but not much on the native protocol. This page hopes to rectify that with information helpful
to those implementing a SD host or trying to understand what they're seeing on an
oscilloscope.

3.11.2 References
= The full MMC Specification is available as JESD84-A44 from the JEDEC website
= The SD Simplified Specification from the SD Card Association covers most of the protocol
= The full SD specification is available after joining the SD Card Association
3.11.3 Compatibility
MMC, SD, and SDHC cards are broadly compatible at the electrical and framing level. A
properly designed controller should be able to handle them all. Some differences are:

= MMC cards are available in both High Voltage (2.7 - 3.6 V) and Dual Voltage (2.7 - 3.6
and 1.70 - 1.95 V)

= MMC is designhed to support multiple cards on the same bus
» During initialisation MMC cards are clocked at 400 kHz or less
= MMC, SD, and SDHC all have different initialisation sequences

3.11.4 Protocol

The protocol is a strict master/slave arrangement where data is clocked synchronously from
the host to the card or from the card to the host over digital lines. Commands are sent from
the host to the card and all commands have either no response, a 48 bit response, or a 136
bit response. Some commands may also start a data transfer to or from the card.

There are three types of signal:

= CLK, carrying the clock signal from the host
= CMD, carrying commands from the host and responses from the card
= DAT, carrying data from the host or data from the card

There may be 1, 4, or 8 DAT lines. SD Cards can run at 0 - 25 MHz in Default Mode or 0 to
50 MHz in High-Speed Mode. MMC cards come in different grades that can run at up to 20,
26, or 52 MHz. No matter what all cards start up in 3.3 V, single DAT, and low speed mode
with any other features negotiated during the initialisation.
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3.11.5 Physical layer

All communication are at 3.3 V logic levels with 3.3 V being a high and 0 V being a low. CLK
comes from the host and idles low. CMD and DAT are bidirectional and idle high. All are
driven in a push/pull mode for speed.

Data is clocked into the host or card on the rising edge of CLK and changes on the falling
edge. This is equivalent to the SPI (0, 0) mode.

3.11.6 Framing

The framing is a bit unusual. It feels like it was written by a embedded software engineer
instead of a hardware or protocol engineer as the framing and use of CRCs is unusual and
inconsistent. The advantage is that the framing maps through to a software only
implementation pretty well.

All transfers start with a zero start bit and finish with a one stop bit. A card may signal that
it is still working on the response by keeping the CMD line high until the response is ready.

All commands are 48 bits (6 bytes) long and all responses are either 48 bits (6 bytes) or
136 bits (17 bytes) long. The 48 bit transfers can be thought of as an 8 bit message ID, 32
bit argument, and 8 bit checksum.

Bytes are transferred most significant bit first. Words are transferred most significant byte
first.

3.11.7 Commands and Responses
A command or response has the following format:

Bit # Value Name

47 1 0 Start bit

46 1 1 for commands, 0 for responses = Transmitter bit
45-40 6 Command ID
39-8 32 Argument

7-1 7 CRC
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0 1 1 Stop bit

The CRC is a 7 bit CRC with polynomial x” + x3 + 1. A table driven form can be found in the
Linux kernel under lib/crc7.c. Bitwise forms may be generated using pycrc with the
parameters

--width=7 --poly=9 --reflect-in=0 --reflect-out=0 --xor-out=0 --xor-in=0 --generate c
--algorithm=bit-by-bit-fast

such as

for (int b = @; b < 8; b++)

{
uint bit = crc & 0x49;
if ((data & ox80UL) != 0)
{
bit "= 0x40;
}
data <<= 1;
crc <<= 1;
if (bit != 0)
{
crc = 0x09;
}
}

Note that the final CRC must be ANDed with Ox7F.

The CRC seed is zero and is calculated over the start, transmitter, command ID, and
argument fields. The resulting CRC is compared for equality with the CRC from the
message.

Some examples are:

An APP_CMD (55) command that prefixes a SD specific command
Bytes: 0x770000000065

Bits: 0 1 110111 00000000000000000000000000000000 0110010 1
Fields:
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» Startbit=0

= Transmitter = 1

= Command = 55 (decimal)
=  Argument = 00000000

= CRC = 0x32

= Stopbit=1

The CRC can be generated by feeding 0x77, 0x00, 0x00, 0x00, 0x00 into the CRC function
above.

The response to the APP_CMD

Bytes: 0x370000012083

Bits: © © 110111 0000VRVVVVVV00VVVV0000100100000 1000001 1
Fields:

= Startbit=0

» Transmitter = 0 (this is a response)
= Response = 55 (decimal)

= Argument = 00000120

= CRC = 0x41

= Stopbit=1

The response to CMD3 SEND_RELATIVE_ADDR

Bytes: 0x03B368050019

Bits: © 0 000011 10110011011010000000010100000000 0001100 1
Fields:

= Startbit=0

= Transmitter = 0 (this is a response)
= Response = 3 (decimal)

=  Argument = 0xB3680500

= CRC = 0x0C

= Stopbit=1

Page

39



@ !EAR1;HPE|OPLE
& B n o o g

MaxProLogic Development System User Manual

Note that this cards Relative Card Address (RCA) is 0xB368

3.11.8 Data
Data has the following format:

Bit # Value = Name
4113 1 0 Start bit
4112-17 512*8 Data bits
16-1 16 CRC

0 1 1 Stop bit

Note that this is for a typical transfer of a block of 512 bytes. The host knows from the
command that was sent how many bytes to expect back. There is no other way of knowing
the message length.

The CRC is is the ITU-T V.41 16 bit CRC with polynomial 0x1021. A table driven version can
be found in the Linux kernel under lib/crc-itu-t.c. Note that there is no such thing as 'the'
CRC16 so make sure you get the right one.

Unlike the commands or responses the CRC is calculated over all of the data bytes and does
not include the start bit. The calculated CRC is checked for equality with the received CRC.

PENDING: Add an example data message with CRC.

3.11.9 Handover

The CMD and DAT lines are bidirectional. Handover occurs at the end of a command where
both the host and the card switch to input mode for two clocks before the card starts driving
in push/pull mode. Some commands must be responded to in a fixed number of clocks but
most allow an arbitrary time before the response must start.

3.11.10 Initialization
To initialise a SD or SDHC card, send the following:

= Write 74 clocks with CMD and DAT high
= Write CMD@ GO_IDLE_STATE. This will reset the card.

= Write CMD8 SEND_IF_COND for 3.3 V parts. If any SDHC cards are
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present then you will get a wired-OR response with 0x3F as the command and OxFF as the
CRC and stop bit. Note that this must be sent or SDHC cards will not respond to the
following steps

Write CMD55 APP_CMD
Receive a 55 response

Write ACMD41 SD_SEND_OP_COND

Expect a wired-OR response with 0x3F as the command and OxFF as the CRC and stop
bit

Check the ready bit in the previous response. If the card is not

ready then repeat the CMD55/ACMD41 until it is

Write CMD2 ALL_SEND_CID

Expect a wired-OR response with 0x3F as the command and OxFF as the CRC and stop
bit

Write CMD3 SEND_RELATIVE_ADDR

Expect a 3 response. The upper two bytes of the argument is the

Relative Card Address (RCA) which is used in the next step

Write CMD7 SELECT_CARD with the RCA
Expect a 7 response

The card is now selected and ready to transfer data. See Figure 4-1 'SD Memory Card State
Diagram' in the simplified spec for more information.

See section 4.7.4 'Detailed Command Description' in the simplified spec for more
information on the commands and responses.

MMC cards are initialised using a similar but different method.

An example flow captured from Linux on a SC2440 is:

Phase Command Response Notes
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CMDO

CMD55

ACMD41
SEND_OP_COND

CMD55

ACMD41

CMD55

ACMD41
SEND_OP_COND

CMD2
ALL_SEND_CID

CMD3
SEND_RELATIVE_A
DDR

4000000000
95

7700000000
65

6900100000
5F

7700000000
65

6900100000
5F

7700000000
65

6900100000
5F

4200000000
4D

4300010000
7F

None

370000012083

3FOOFF8000FF

370000012083

3FOOFF8000FF

370000012083

3F80FF8000FF

3F1D4144534420202010A0400BC1008
8ADFF

03B368050019

Card
is
busy

Card
is still
busy

Card
is
ready

RCA
of
0xB36
8

Note the missing CMD8 as this controller does not support SDHC. I didn't capture the final

CMD?7.

3.11.11 Reading

Once initialised reading from a card is straight forward.

To read a single page:

= Send CMD17 READ_SINGLE_BLOCK with the offset to read from as the argument
= Receive on the DAT lines

= Send CMD12 STOP_TRANSMISSION once the block has been received
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To read consecutive pages:

= Send CMD18 READ MULTIPLE_BLOCK with the starting offset as the argument
= Receive as many blocks as you want on the DAT lines

= Send CMD12 STOP_TRANSMISSION once the done
Note that there will be a response to these commands and the response may be interleaved
with the data. See Figure 3-3: (Multiple) Block Read Operation for more information.

On SDHC cards the offset is in terms of 512 byte blocks. On SD cards the offset is in bytes
and the number of bytes received depends onCMD16 SET_BLOCKLEN

3.12 Power Input
The MaxProLogic is designed to be operated from one of four different power sources:
e Standard USB cable from Laptop/PC.
e +5 VDC wall charger (phone charger) through USB cable.
e +4.5to0+5.5 VDC supplied through the DC power jack.
This provides power for a high-efficiency switching regulator on-board to provide +3.3 VDC.
The power supply provides reliable power under dynamic loads and high frequency switching
internal to the FPGA.
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BARREL CONNECTOR
FOR POWER

iEr.ecl NnULL

el . _NAXPROL( GIC(f7
USB C CONNECTOR =) if , ’
nn

+3.3V POWER SUPPLY

BARREL CONNECTOR USB-C CONNECTOR

+5VDC - +6VDC PM

INNER CONDUCTOR GND ON OUTER
CONDUCTOR

3.13 On/Off Control

The MaxProLogic is equipped with an On/Off circuit. This circuit consists of a push button
switch that is momentary contact and a MAX16054 controller chip. The controller senses the
change in state of the momentary switch and drives the output “PWR_ENABLE” signal to the
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+3.3 VDC power supply. The enable pin of the TPS54229 has the following truth table:

Enable Pin | Output of

TPS54229
High +33V
Low ov

SWITCH-PWR
SELECTION

ON/OFF CONTROL

ON/OFF
SWITCH

10MO4SAE144C8G |
E BAGAZ22234

§§1 3 c " n oLo '
Iuvlotoalc ﬂ! !
Sy ‘-mmumuwummmmunu
it = - ul«-ml 1 LIt

-
-u
—
(]
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x as
vz
3 l : , ] e CTSSI 554
swmenemcrs I Rl W e w .
{ Iw 8 s il
" MAX16054_SOT234 o i VREGS GND 3
P L l o % @ o l = g :
A o cn Tem R
= on/off Controller IV I"” _L sz POSOS 2

¥ A—a
g T A AA— Buck Switching Regulator
P o "
= 7K = I ShE & &l oA 18
M we =
2 F 4 2,
Voltage Supervisor E“ﬁ:m‘&y

Inverter

Use the Pushbutton SW1 to turn the power on to the MaxProLogic.

The TPS54229 Synchronous Buck Regulator will take any noisy input power and provide a
smooth stable output. It has a fast transient response with a large inductor on the output.
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The MAX16054 Controller chip also has a ‘CLEAR’ input. This input allows secondary device
to cause a shutdown. The CLEAR input has the following truth table:

Clear Pin Output of
TPS54229
High +33V
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Low ov

The On/Off controller can be bypassed and allow the MaxProLogic to power up whenever power
is applied. This selection of the “SW” or “PWR” is made using the JMP2 jumper.

I
S 6
1

cu DWD
XX |
D]
12C SENSGR 1/0 SEL

PWR IN
+5V

JMP2 =

o RE=
E::J = " CONF_DONE

MEESGRHENEONIES QNG

MAXPROLOGI ™

-
l —

j ! EARTHPEOPLE

I

The JMP2 provides the bypass. Set the jumper to the ‘1’ position to use the On/Off pushbutton
switch.
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|
St
1

cw  DWD

|7.\|1
6

PWR IN
'5V 'ZC SENSGPR

JMP2
=] - o _DONE

]
: I EARTHPEOPLE
I

SHERCRHENE ORING F CEy e X

MAXPROLOGI "

I
‘ 5. £C)
cul DWD
' o
6

PWR IN
.sv 12C SENSOR

JMP2
:| - G _DONE

l
l EARTHPEOPLE
£

SEEACREENE GRS CE e )

MAXPROLOGI"

In this IMP2 setting, the MaxProLogic will power up when power is applied either through the
USB-C or Barrel Connector.
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3.14 Communications Interface
The MaxProLogic is equipped with a communications port that is compatible with FTDI
Breakout Boards. It is a 6 pin female header that connects directly with most Breakout boards.
The Communications Connector provides a path between the FTDI Breakout Board and the
MAX10 FPGA. It brings both the RX and TX signals into the FPGA at the following pins.

Communications | MaxProLogic FPGA Signal MAX 10 Pin
Connector-Pin Schematic Number
Number Signal
J9-1 NC --
J9-2 RX COMMS UART RX 92
J9-3 X COMMS UART TX 93
J9-4 VCC --
J9-5 NX --
J9-6 GND --
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L PAGE - 4 of 13
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JMP1
JUMPER_100_MIL_2x1

J8

1
= EXT_UART_RX
BT OART TR
=

ADER_100_MIL_8X1

‘ 2
-
A
/ /ﬂ\\
L'_.
>
"

— c&

GND
- oMwF
7ALVC1G17-SCHMITT_SOT353
= UsE 1T TRIGGER

U4z
10_8_92/DIFFIQ_RX_R18P

107693/l
10

M 1

e
st

IFFIO_RX_R18N
HEADER_100_MIL_10x1 IFFIO_RX_R27P

10_6_100/DIFFIC_RX_R26P
705 10_6_101/DIFFIQ_RX_R27M
705 10_6_102/DIFFIO_RX_R26N
106 | 10_6_105/DIFFIO_RX_R33P

10_6_106/DIFFIO_RX_R33M

?_TT
The MaxProLogic Communications Interface is compatible with both +5V and +3.3V Breakout
Boards. The JMP1 provides a user selection jumper to select the +5V and +3.3V interface. There

are two 74LVC1G17 Schmitt Trigger chips to provide voltage level compatibility with the
FPGA.
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L]
EARTHRPEORLE
VEGHNOLOGY

MAXPROLOGI"

CCMMS
1/0°SEL

JMP1 .
|

COMMS Tn * —
I[/0 Ry

Add a two pin jumper to pins 2 and 3 of JMP1 to select +5V Input/Output.
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0
0 ® 3 3y
0 (/0
CCMMS 5V
1/0 SEL ﬁ\
JMP:|1°

\l. ‘
COMMS T © —
[/0 Ry

3.14.1 UART Communication Protocol

The FPGA must run Verilog code to perform the full duplex UART communications. The code
must decode in the incoming RX signal and produce the outgoing TX signals with an accuracy of
greater than 99%. This means up to 1% error i1s acceptable. The UART signals are based on a
protocol. Where the UART protocol indicates one start bit, eight data bits and one stop bit.
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LEAST MOST
SIGNIFICANT SIGNIFICANT
BYTE BYTE

BITO BIT1IBIT2|B|T3 BITO|BIT1|BIT2 BIT3

T T L)

XX XX

.

START BIT STOP BIT
BIT 3 BIT 2 BIT 1 BITO BIT 3 BIT 2 BIT 1 BIT 0
0 1 1 1 0 1 0 1
8*0=0 4*1=4 2*1=2 1*1=1 8*0=0 4*1=4 2*'0=0 1*1=1
MOST SIGNIFICANT BYTE LEAST SIGNIFICANT BYTE

Each bit of the protocol must assert in the allocated time slot for each bit. What this means is that
the clock used to time each bit of the protocol is embedded in the data. Both the sending device
and receiving device must use the same clock rate. This embedding of the clock into data rate is
called the baud rate.

The baud rate describes the data rate in bits per second. The timing diagram for a baud rate of
115,200 is 8.68 microseconds per bit.
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95.48

usec

8.68 8.68 8.68 8.68 8.68

8.68 W0C 865 N0 ‘ggg USEC gy USAC ggg USEC
useac usec

usec usec

8.68

usec usec

START BIT 8 DATA BITS / STOP BIT

For the incoming RX signal, the FPGA must sample each bit of the protocol at four times per bit.
This sampling rate is critical as the sending device clock and the receiving device clock are not
synchronized. If the sampling rate is too low, a transition may be missed. If the sampling rate is
only two times greater than the period of the receive device clock, samples could fall in the rising
of falling edge of the received signal. Any time a sample occurs on the rising or falling edge, it
runs the risk of reading a metastable result or undetermined result.

SAMPLING MUST
OCCUR AT THE RATE >
FOUR TIMES PER

PERIOD | \

ONE PERIOD IS
ONE BIT

The Verilog code is written so that a special Baud Rate Clock is used to drive the UART Receive
Block.
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UART
BAUD MAIN
RATE CLOCK
CLOCK
: L RXD
BAUD RATE CLOCK DRIVES BIART TOP LEVEL XD FTDI USB TO
THE SAMPLING OF THE : UART
RECEIVE SIGNAL \ .......................... ; .[

RECEIVE

TRANSMIT

This code will use the Baud Rate Clock to drive a conditional if statement. The if statement will
branch when a transition occurs and records the state of the signal (1 or 0). The Baud Rate Clock
must be set to four times the incoming signal bit rate.

3.15 JTAG Interface
The MaxProLogic has a 5x2 header for use in programming the MAX10 FPGA via JTAG. The
connector is located in the bottom right corner of the MaxProLogic. It is shrouded and keyed to
allow easier insertion.

Page

56



@ !EAR'I;HPEPPLE
g £ n o o g

MaxProLogic Development System User Manual

com L
g losal_ JTAG CONNECTOR

This connector uses the standard Altera Blaster connector pinout.

TCK 1| 2 |- GND
™0 - 3| 4 |- vcc(treT
™S 5| 6 | NC
=8 B
™ - 9|10 anp

The VCC(TRGT) is set to +3.3V on the MaxProLogic. There are no jumper settings to make in
order to program the MAX10 FPGA. Just connect a compatible Blaster to the connector and the
PC, then use the Quartus software to program the FPGA.
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Please see the “Programming the FPGA™ section for a full description of the JTAG programming
process.

4 Powering the MaxProlLogic
You can run the MaxProLogic from a laptop with 2.5W of power. Or you can run it from the
+5V @ 2A wall USB chargers for 10W of power. The barrel connector can handle up to +5.5V
@ 3 A for 15W of power.

e Standard USB cable from Laptop/PC.

e +5 VDC wall charger (phone charger) through USB cable.

e +4.5to0+5.5 VDC supplied through the DC power jack.
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BARREL CONNECTOR USB-C CONNECTOR

+5VDC - +6VDC PM
INNER CONDUCTOR GND ON OUTER

CONDUCTOR

The barrel connector is the typical size used on many popular DIY boards such as the Arduino
series. It has the following mechanical specs:

e 2.0mm Inner Diameter

e 5.5mm Outer Diameter
The barrel connector does not include a diode protection to prevent reverse polarity connection.
So, care must be exercised when connecting up your cable to the barrel connector. Please ensure
the correct polarity connections are made before connecting to the MaxProLogic. Also, there is
no discrete protection to the power input. The power supply does include a high current
protection circuit. The current limit is around 4.7Amps. But, the MaxProLogic is only designed
to handle 2Amps of current. So, damage may occur to the MaxProLogic if the user does not
exercise care in design and use of the Inputs/Outputs.
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Power the MaxProLogic directly from the PC. +5V@0.5A

Power the MaxProLogic directly from the wall charger. +5V(@2A

5 Installing Quartus
You must install Quartus Prime to configure the CycloFlex. Altera Quartus Prime must be
downloaded from the Altera website.
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Download the Quartus Prime by following the directions in the Section Downloading Quartus.

5.1.1 Downloading Quartus

The first thing to do in order build a project in Quartus is to download and install the application.
You can find the latest version of Quartus at:

Intel FPGA Quartus Prime Lite

**Please be advised, Intel is prone to changing their website graphics every few months.
The guide below is several months out of date. Please follow the latest instructions on the
Quartus Prime Lite Download website. The instructions here are only meant as a guide to
getting the software downloaded.**

You will first need to apply for an account with Intel. Then use your login and password to
access the download site. Click on the Download Windows Version.

M PRODUCTS  SUPPORT  SOLUTIONS  DEVELOPERS ~ PARTNERS  FOUNDRY R Peass Q, search Intelcom

FPGA Software Download Center v

Intel® Quartus® Prime Lite Edition Design Software Version 221 for
Windows

1D Date Software Type Software Package Version Operating Systems

A newer version of this software is available, which includes functional and security updates. Customers should click here to update to the latest version.

soeqpasy

The Intel® Quartus® Prime Lite Edition Design Software, Version 22.1 includes functional and security updates. Users should keep their software up-to-date
and follow the technical recommendations to help improve security. Additional security updates are planned and will be provided as they become available.
Users should promptly install the latest version upon release.

Intel* Quartus® Prime Lite Edition Design Software, Version 22.1 is subject to removal from the web when support for all devices in this release are available in
a newer version, or all devices supported by this version are obsolete. If you would like to receive customer notifications by e-mail, please subscribe to our

subscribe to our customer notification mailing list.

If you are using floating license server for Intel FPGA software, you need to upgrade to the latest license daemon software (v11.18.2.0). Intel FPGA software,
version 22.1, doesn't work with old version of daemon software. You can download the daemon software from this link

To find software versions that support specific device families:
« Refer to the Device Support List

+ Use the Software Selector

Critical Issues and Patches for the Intel® Quartus® Prime Lite Edition Software, Version 22.1.
Knowledge Base: Search for Errata.

Scroll down the page to the “Downloads” section.

Page

61


https://fpgasoftware.intel.com/?edition=lite

@ TEARTHPEOPLE

e ¢ h n o | o g Yy

MaxProLogic Development System User Manual

Critical Issues and Patches for the Intel® Quartus® Prime Lite Edition Software, Version 22.1.
Knowledge Base: Search for Errata.
Problems and Answers on specific IP or Products.

Multiple Download Individual Files Additional Software Copyleft Licensed Source

Multiple Download

Intel® Quartus® Prime Lite Edition Software (Device support included)

Size: 5.5 GB
Quartus-lite-22.1std.0.915-windows.tar SHA1: 86cd25b014999bbbb4c2f0a38bfc3442438759d4

Download

** Nios® Il EDS on Windows requires Ubuntu 18.04 LTS on Windows Subsystem for Linux (WSL), which requires a manual installation.
** Nios® Il EDS requires you to install an Eclipse IDE manually.

** Total space required is 26.10 GB including tar file (5.48 GB), untarred files (5.48 GB) and installation (15.13 GB)

What's Included?

Yoeqpeey

Download and install instructions:
1. Download the software .tar file and the appropriate device support files.
2. Extract the files into the same temporary directory.
3. Run the setup.bat file.

Read Intel® FPGA Software Installation FAQ

Note: The Intel® Quartus® Prime software is a full-featured EDA product. Depending on your download speed, download times may be lengthy.

Detailed Description

System Requirements:
Operating System Support

Minimum Disk Space for Intel® FPGA Software

Click on the “Download Quartus-lite-22.1 xxxxxx Windows Tar.
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Yoeqpeey

Critical Issues and Patches for the Intel® Quartus® Prime Lite Edition Software, Version 22.1.
Knowledge Base: Search for Errata.
Problems and Answers on specific IP or Products.

Downloads

Multiple Download Individual Files Additional Software Copyleft Licensed Source

Multiple Download

Intel® Quartus® Prime Lite Edition Software (Device support included)

Size: 5.5 GB
Download
Quartus-lite-22.1std.0.915-windows.tar SHA1: 86cd25b014999bbbb4c2f0a38bfc3442438759d4

(G5 L on Windows Subsystem for Linux (WSL), which requires a manual installation.
** Nios® Il EDS requires you to install an Eclipse IDE manually.
** Total space required is 26.10 GB including tar file (5.48 GB), untarred files (5.48 GB) and installation (15.13 GB)
What's Included?

Download and install instructions:
1. Download the software .tar file and the appropriate device support files.
2. Extract the files into the same temporary directory.
3. Run the setup.bat file.

Read Intel® FPGA Software Installation FAQ

Note: The Intel® Quartus® Prime software is a full-featured EDA product. Depending on your download speed, download times may be lengthy.

Detailed Description

System Requirements:
Operating System Support

Minimum Disk Space for Intel® FPGA Software

Click through the Legal Stuff.
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(intel)  software License Agreement

Legal Disclaimer

PLEASE NOTE: This version of software ("Software") does not contain the latest functional
and security updates. In order to use this version, you must first acknowledge the following
term, which supplements and supersedes any inconsistent provision in the version of the
Intel & FPGA Software License Subscription Agreement for the product (e.g.. Intel®
Quartus® Prime Software, Intel® HLS Compiler, Intel® FPGA SDK for OpenCL™, DSP
Builder for Intel® FPGAs, or Advanced Link Analyzer) with which vou use the Software:

Intel does not give or enter into any condition, warranty, or other term:

1 with respect to any malfunctions or other errors in its Software caused by virus.

infection, worm or similar malicious code not developed or introduced by Intel; or

il. to the effect that any Software will protect against all possible security threats,
including intentional misconduct by third parties. Intel is not liable for any downtime or
service mterruption, for any lost or stolen data or systems, or for any other damages
ansing out of or relating to any such actions or mtrusions or resulting from use of
Software. Intel does not give or enter into any condition_ warranty. or other term with

respect to interoperability.

Intel does not warrant or assume responsibility for the accuracy or completeness of any
information, text. graphics, links or other items within the Software. Please click “Accept”
below to continue the download process.

Terms of Use | Privacy | Legal Information | © Intel Corporation

This will start the download.
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GoogleMaps [ EPT [ Banks [ Electronics [ News [J Music [ Pay [ Markets [J Reference [J Knowledge [ Tickets [ Nights

Software License Agreement

Thank you. Your document should download automatically.

CHECK THE DOWNLOAD PROGRESS

If the file does not start to download, please click this link

Terms of Use | Privacy | Legal Information | @ Intel Corporation

The file is 13.9 GB (or greater), so this could take a couple of hours depending on your internet
connection. When download is complete, store the *.tar file in a directory on your PC.
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¥ = | C\Jolly\Downloads\Altera_Intel_FPGA\Quartus Prime 20
Home Share View

« v > ThisPC » Local Disk (C:) » Jolly » Downloads » Altera_Intel FPGA » Quartus Prime 20.1
Code FPGA 6 MName Date modified
Documents
Th
Downloads
Allegro

Altera_Intel_FPGA
Quartus Prime 16 *
Quartus Prime 17.1
Quartus Prime 181
Quartus Prime 20.1

AtmosFX

Camtasia

FTDI

HyperSerialPort

E l = | C\Users\nelso\Downloads

File Home Share View

+ ; » This PC » Local Disk (C:) » Users » nelso » Downloads

3 This PC 2

MName
- 3D Objects ~ Today (1)
[ Desktop D Quartus-lite-20.1.0.711-windows. tar
@ Documents . -
CaliicT s WETK (1)
Download
¥ Downloads Label-501986027.pdf
J‘! Music
_ ~ Last week (1)
&= Pictures
g vid Label-501432798,pdf
Ideos
i Local Disk (C3) v ¥ Lastmonth (18)

Use a tool such as WinZip to Extract the *.tar file.
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Unzip/Share Edit

Files # -

< Files
Recent Zip Files

gy Quartus-lite-20.1.0.7....tar
“al | Quartus Prime 20.1

Browse & Manage Files

§ Yy Frequent Folders
a9

m This PC

= 648 GB free of 930 GB

[‘, Network

¥ Shared Files

[
N

Add Cloud

MaxProLogic Development System User Manual

Backup Toals Settings View Help Buy Mow

Activate WinZip before your trial runs out!

(W7 B0V NOW

Quartus-lite-20.1.0.711-windows.tar

>

components Date modified: 6/6/2020 6:33 PM
Type: Folder

= readme.txt Date modified: 6/6/2020 7:09 PM

=| Type Readme Document Size: £.51KB =+ 8.51KB
setup.bat Date modified: 6/6/2020 7:09 PM

= Type: Windows Batch File Size: .O7KB + 1.07KB

D3 itemn(s)

Zip File: 11 item(s), 5.90 GB

The tool will unpack all files.

WinZip —

Extracting ModelSim5etup-20.1.0.711-windows.exe

Cancel

..........................................

I l 3
Purchase risk-free TODAY from our secure online shop. @' mﬂw*u'.guﬁ &

Actions
Unzip All Files

E Unzip to: v
=\Quartus-lite-20.1...

Convert & Protect Files
When adding files to this Zip file:

a Encrypt .
E] Reduce Photos
Q Remove Info

E‘_ Convert Photos
% Convert to PDF

E% Combine PDFs

_I_ Watermark

5.1.2 Quartus Installer
When the unpacking finishes from the previous section, double click the setup.bat file in the

download folder.
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B B B - | CVoll\Downloads\Altera_Intel FPGA\Quartus Prime 20.1

File Home Share View
* lJ 4 cut X I-iENewiT:errl' |j Open ESelectaH
w-| Copy path . ﬂ Easy access = Edit Select none
Pinto Quick Copy Paste Move Copy Delete Rename New Praperties
access d Paste shortcut to to - falder - £ History DDInuer‘t selection
Clipboard Organize Mew Open Select
“« v A » ThisPC » Local Disk (C:) » Jolly » Downloads » Altera_Intel FPGA » Quartus Prime 20.1
~
Quartus Prime 16 -~ Name Date modified Type
Quartus Prime 17.1 components 8/8/2020 12:58 PM File folder
Quartus Prime 18.1 2 Quartus-lite-20.1.0.711-windows.tar 020 12:25 PM WinZip File
> Quartus Prime 20.1 =| readme.txt M Text Docurnent
AtmosFy PM Windows Batch File
Camtasia
FTDI

HyperSerialPort

Click “Next” on the Introduction Window.
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v Installing Quartus Pnme Lite Edition (Free) 20.1.0.711 — O
Setup - Quartus Prime Lite Edition (Free) 20.1.0.711

Welcome to the Quartus Prime Lite Edition (Free) 20, 1.0.711 Setup Wizard,

The Quartus Prime software requires that your system have sufficient physical RAM to compile designs
targeting specific devices. You can check the "Memory Recommendations™ section in the "Quartus Prime
Software and Device Support Release Notes™

(https: { fwww.intel. comjcontentfwww fus fen fprogrammable fdocumentation fit-rn. himl) for detailed
memory requirements for a particular device,

For more information about Intel FPGA software, go to
https: /fwww.intel.comjcontent/www jus fen/products fprogrammable. html.

< Back Mext > Cancel

Click the checkbox to agree to the license terms. Then click “Next”.
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v Installing Quartus Pnme Lite Edition (Free) 20.1.0.711

License Agreement ( intel,

You can view the full license agreement at the link below or use --nstall_lic option from command-ine to get the license agreement
files befare the installation. You must accept the terms of the agreement before continuing with the installation.

http: {{fpgasoftware.intel. comeula/

QUARTUS PRIME AND INTEL FPGA IP LICEMNSE AGREEMENT, VERSION 20.1 ~

Intel, Quartus and the Intel logos are trademarks of Intel Corporation
or its subsidiaries in the US and other countries. Any other
trademarks and trade names referenced here are the property of their
respective owners.

DO NOT DOWNLOAD, INSTALL, ACCESS, COPY, OR USE ANY PORTION OF THE

LICENSED SOFTWARE UNTIL YOU HAVE READ AMD ACCEPTED THE TERMS AND

CONDITIONS OF THIS AGREEMENT. BY INSTALLING, COPYING, ACCESSING, OR W
£ >

(®) I accept the agreement
Do you accept this license?
() 1 do not accept the agreement

InstallBuilder
< Back Mext > Cancel

Click “Next” and accept the defaults.

At the Select Products Window, de-select the Quartus Prime Supbscription Edition by clicking
on its check box so that the box is not checked. Then click on the check box by the Quartus
Prime Web Edition (Free).
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v Installing Quartus Pnme Lite Edition (Free) 20.1.0.711

Select Components

Select the components you want to install

= [#] Quartus Prime Lite Edition (Free) Installs Arria II device support, (536, 5MB)
i Quartus Prime {indudes Nios II EDS) (9313MB)
Quartus Prime Help {508.4ME)
Devices
W :Arria 1T (536.5MB)
Cydone IV (516.3MB)
Cydone 10 LP {293.5ME)
Cydone v {1434, 3MB)
[ MAX IV (13.1M8)

‘.. [] MAX 10 FPGA (360.3MB)
Modelsim - Intel FPGA Starter Edition (Free) (4318,8MB)
- [] ModelSim - Intel FPGA Edition (4318.8MB)

InstallBuilder
< Back Mext = Cancel

Click “Next” to accept the defaults
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v Installing Quartus Pnme Lite Edition (Free) 20.1.0.711

Ready to Install intel.

Summary:

Installation directory: C:intelFPGA_lite\20. 1
Required disk space: 16750 MB
Available disk space: 657864 MB

InstallBuilder
< Back Mext = Cancel

Click “Next” to accept the defaults
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v Installing Quartus Prime Lite Edition (Free) 20.1.0.711

Installing @

Wait while Setup installs Quartus Prime Lite Edition (Free) 20.1.0.711

Installing
Unpacking files
InstallBuilder
< Back Mext = Cancel
Wait for the installation to complete.
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Mailings Review View Help | O Installing Quartus Prime Lite Edition (Free) 20.1.0.711

Emphag

Installing

|
=
Eatagiapt B | Wait while Setup installs Quartus Prime Lite Edition (Free) 20.1.0.711

| Installing
Installing ModelSim - Intel FPGA Starter Edition (Free)...

L I R BRI SRR B

Tha Ales Fromale frshad rataieg the
= Quartua T Web B {Foee] (nchdes sion T £D5)
" Motesm Ak Sunar ot (Frexl

LALANARY

=

Stan Qs B 2.3
41 s I Subsrten Loesss

THate Desktog Shartouts

¥ Quaartan 1 Wl Esiton [Fres]) andi Hios 11 ST | Mas I G004 Togkhan
¥ ModeimAtera Stater Edtion (Free)

— ¥ Installing ModelSim - Intel FPGA Starter Edition 20.1.0.711

he Qua Installing
Installing ModelSim - Intel FPGA Verilog model files...

arto (I

s ¢ EathPeople Technology ® EPT USS-CPLD Developenent 5y5

einfibrary »  Hew folder
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v Installing Quartus Pnme Lite Edition (Free) 20.1.0.711 — O
Quartus Prime Lite Edition (Free) 20.1.0.711 Installation Complete

Setup has finished installing Quartus Prime Lite Edition (Free) 20.1.0.711.
Launch USB Blaster II driver installation

Create shortcuts on Desktop
Launch Quartus Prime Lite Edition
] Provide your feedback

< Back Finish Cancel

Click “Ok”, then click “Finish”. The Quartus Prime is now installed and ready to be used.
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¥ Quartus Prime 20.1 Lite Edition

Thank you for installing the Quartus Prime software - the #1 in performance and productivity. To
upgrade to a full featured edition, please

https:/fwww.intel. com/contentfwwwius/enfproducts/programmable himl

Select one of the following licensing options to continue:

Select one of the following options

O Buy a Quartus Prime software license

(Z) Run the Quartus Prime software

() Add an IP license file (for users who have purchased IP)

OK Cancel

At this point the Quartus Prime Lite software is installed. Go to the Windows button and type in
“quartus” at the search prompt.
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Jeortant huninshiic lan inradicte larnmmmmmahla himml

vin

Q quar‘lus|

| & @ Apps Documents Web Settings Folders Et » g2 T N e 4

|
2ri
il Best match
I G Quartus (Quartus Prime 20.1)
— App
fht' Apps Quartus (Quartus Prime 20.1)
P App
G Quiartus (Quartus Prime 23.1std) >
D
=t = ModelSim - Intel FPGA Starter > [Er
ch Edition Model Technology
>
‘g Programmer (Quartus Prime 20.1) >
Recent
Documents
|& EPT_10CLOT6_AF T2 Top.gpf - in EPT 10CLO16 AF T2..
quartus2.greg > [3) EPT 10M04 AF S2 Top.gpf - in EPT 10M04 AF 52 Top
Search the web {3 EPT 10MO4_AF 52 Top.qpf - in EPT 10M04_AF 52 Top
B EPT 10M04_AF 52 Top.qpf - in EPT 10MO4_AF 52 Top
ﬂ Quartus >
{3 EPT 4CE6 AF D1 Top.qpf- in EPT 4CE6 AF D1 Tap
Q. quartus prime » {3 EPT_4CE6_AF_D1 Top.gpf - in EPT 4CE6 AF D1 Tap ||
= i » |3 EPT_4CES_AF_D1_Top.gpf - in EPT_4CE6_AF D1 _To :
quartus ii P-qp P

@ EPT_10MO4_AF_S2_Top qpf - in EPT_10MO4_AF_52_Top

l Q. quartus download > I

- [ EPT_10CLOI6_AF T2 Top.gpf - in EPT_10CLO1G_AF T2..

The Windows Search should locate the installed version of Quartus. Click on the icon and the
software should load properly. If this does not occur, contact Earth People Technology for
support. There are three methods to contact EPT for support:

https://www.earthpeopletechnology.com->Forums
support@earthpeopletechnology.com
sales@earthpeopletechnology.com
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6 Compiling, Synthesizing, and Programming the FPGA

QUARTDS: \
PRIME /

DESIGN SOFTWARE

The FPGA on the EPT-10M04-AF-S2can be programmed with the Active Transfer Library and
custom HDL code created by the user. Programming the FPGA requires the use of the Quartus
Prime Lite software and a standard USB cable. There are no extra parts to buy, just plug in the
USB cable. Once the user HDL code is written according to the syntax rules of the language
(Verilog and VHDL) it can be compiled and synthesized using the Quartus Prime Lite software.
This manual will not focus on HDL coding or proper coding techniques, instead it will use the
example code to compile, synthesize and program the FPGA.

6.1 Setting up the Project and Compiling

Once the HDL code (Verilog or VHDL) is written and verified using a simulator, a project can
be created using Quartus Prime Lite. Writing the HDL code and simulating it will be covered in
later sections. Bring up Quartus Prime Lite, then use Windows Explorer to browse to
C:\Users\<Your PC>\Documents create a new directory called: “EPT _10M04 AF Blinky”.

<« I @] J > ThisPC > Windows(C) > Users > nelso > Documents >
® New ¥ @ @D W T sort = vView
stmeufinder O Name Date modified
I3 3D Objects EPT_4CE6_AF_Platform_Demo 5/25/2024 9:18 PM
AppData EPT_10CLO16_AF_System Demo 2/8/2025 3:05 PM
- @  EPT_10MO4_AF Blinky 4/5/2025 3:29 PM
. Application Data
- My Music 2/19/2021 6:44 PM
cdssetup
- My Pictures 1 PM
Contacts
4 My Videos 2/19/2021 6:44 PM
- Cookies
Visual Studio 2019 2/27/2021 4:39 PM
S Documents
EPT_4CEG_AF_Platform_Demo
EPT 10CLO16 AF Svstem Demo
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Open Quartus Prime Lite by clicking on the icon

A
Quartus

(Quartus
Prime 20.1)
Lite Edition

(G Quartus Prime Lite Edition

File Edit View Project Assignments Processing g Tools Window Help

OrFH+-D0NC

Sroject Nawgalur{ % Hierarchy

v|Qggx

i Compilation Hierarchy

Tasks Compilation =88 x

Task

¥ P compile Design
> P Analysis & Synthesis
> P Fitter (Place & Route)

> P Assembler (Gen

[ ST,

- a X

Search altera.com []

0 4E2SrrFE L0 H

|\P Catalog.

na
Device Family |MAX V.
v i installed 1P
' Project Directory

|

No Selection Available
¥ Library
> Basic Functions
> pse
> Interface Protocols
> Processors and Peripherals
> University Program

@ search for Partner 1P

Quartus Prime

w Buy Software
5
]

+ Add

All @ @ El ‘i <<Filter>>

[ 88 Find.. | |88 Findvex|

Illﬁmx"‘

Type ID  Message

[
g
i

Ed

System  Processing

100%  00:00:14

Under Quartus, Select File->New Project Wizard. The Wizard will walk you through setting up
files and directories for your project.
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' Quartus Prime Lite Edition

File Edit View Project Assignments Processing Tools  Window  Help

[ New. Ctrl+N M & X < SadVy e
f~ oOpen. Ctrl+0 & Home o
Close Ctrl+F4&
[ ew project wizard.. Recent Projects
"B Open Project.. Ctri+J EPT_4CE6_AF_D1_Top.qpf (C:/Jolly/Products/Earth People
Save Project Technology/DUEPR IC_USB_FPGA PROJECT 3.0 DVD/Projects HDL,
Close Project EPT_5M57_AP_U2_Top.qpf
{C:/Jolly/Code FPGA/EPT 5M57 AP U2 Transfer Test/EPT 5M57_AP U3
Save Ctrl+S
Save As_.
A save all Ctrl+Shift+S ﬁ‘ Open Proje

File Properties...

Create [ Update L4 ii ﬁ

Export...
2 Compare Editions Buy Software Documentation Training
Convert Programming Files...

Page Setup... . ‘
Print Preview What's New Naotifications

Print... Ctrl+P

c =

Recent Files L

MO Eind.. 88 Find Next

Recent Projects ’

Exit Alt+F4

Messages

System Processing

Starts the Mew Project Wizard

The Introduction Page will open.
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G New Project Wizard X

~

Introduction

The New Project Wizard helps you create a hew project
and preliminary project settings, including the following:

Project name and directory

Name of the top-level design entity

Project files and libraries

Target device family and device

EDA tool settings

YOU Can cnange e setungs 1or an exisung project ana
specify additional project-wide settings with the Settings
command (Assignments menu). You can use the various
pages of the Settings dialog box to add functionality to

tha nraine +

¢ 4+ & e @

Don't show me this introduction again

Help < Back |Next>| FEinish |Cancel

Go to your project saved at C:\Users\<Your PC>\Documents directory and add a new directory
under the project directory. Type in a name for your project “EPT _10M04 AF S2 Top”.

& 1» (@] J > ThisPC > Windows(C) > Users > nelso > Documents > EPT_10MO4_AF Blinky >
@ New Tl sort = View
Cookies ] Name Date modified Type Size
v Documents EPT_10M04_AF_S2_Top 4/5/2025 3:35 PM File folder

EPT_4CE6_AF_Platform_Demo
~ EPT_10CLO16_AF_System_Demo
EPT_10CLO16_AF_T2_ Top
src
v EPT_10MO4_AF_Blinky
EPT_10MO4_AF_S2_Top

> 24 My Music

My Pictures

Hit the “Next” key on the Intro page.
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At the Top-Level Entity page, browse to the C:\Users\<Y our PC>\Documents directory to store
your project. Select the directory under the project name: EPT 10M04 AF S2 Top. Then add
this name to the name of the project and top level of project.

G New Project Wizard X

~

Directory, Name, Top-Level Entity

What is the working directory for this project?
lents\EPT_10M04_AF_Blinky\EPT_10M04_AF_S2_Top| ...
What is the name of this project?
EPT_10M04_AF_S2_Top

What is the name of the top-level design entity for this
project? This name is case sensitive and must exactly
match the entity name in the design file.

EPT_10M04_AF_S2_Top

Use Existing Project Settings...

Help <Back |Next> FEinish Cancel

Select Next. At the Project Type page. Select “Empty Proejct”. Then hit Next button.

G New Project Wizard X

Project Type
Select the type of project to create.

® Empty project

Create new project by specifying project files and
libraries, target device family and device, and EDA tool
settings.

Project template

Create a project from an existing design template. You
can choose from design templates installed with the
Quartus Prime software, or download design templates
from the Design Store.

Help <Back Next> Finish Cancel
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Next, navigate to the MaxProLogic Project DVD. Locate the

$/MAXPROLOGIC FPGA PROJECT 4.x DVD /Projects HDL/EPT 10M04 AF Blinky
folder.

€ T &} J > ThisPC > Windows(C) > Jolly > Products > Earth People Technology > ODINLINK MAXPRO_DEV_SYS_PROJECT 27.DVD > Search ODINLINK_MA
@ Mew M ML Sort = View
> ESP32_DJ_SNACK_PACK_PROJECT_4.0_DVD O Neme Date modified Type Size
v MAXPROLOGIC_FPGA_PROJECT 4.1_DVD Documents File folder
Documentation Drivers File folder
Projects_HDL File folder
> Drivers
Projects_Software File folder
~ . Projects HDL
Quartus Prime 17.1 File folder
I’ EPT1OMO4AF Blinky I Tutorizls File folder
> EPT_10MO4_AF_Control_Statements

> EPT_10M04_AF Flip_Flop
> EPT_10M04_AF Operators.
> EPT_10MO4_AF_Temp_Sensor
Quartus_20.1_Prime
> Tutorials

> MEGAMAX_CPLD_SYSTEM_PROJECT_4.5_DVD

|
Navigate to the $/MAXPROLOGIC FPGA PROJECT 4.x DVD
/Projects HDL/EPT 10M04 AF Blinky/src source folder.

&« e c o > = Jolly > Products > Earth People Technology » MAXPROLOGIC_FPGA_PROJECT 4.1_DVD > Quartus_20.1_Prime Search
@ New Tl Sort = View
> ESP32_DJ_SNACK_PACK_PROJECT_4.0_DVD O Name Date modified
~ MAXPROLOGIC_FPGA_PROJECT 4.1_DVD This folder is empty.
Documentation

bl Drivers
~ Projects_HOL
- EPT_10MO4_AF_Blinky
> EPT_10M04_AF 52 Top

ModelSim
sim
src
test
Testbench

> EPT_10MO4_AF_Control_Statements

|
Select the “EPT _10M04 AF S2 Top.v” file, right-click and select copy.
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& ™ [&] J > - Earth People Technology > MAXPROLOGIC_FPGA_PROJECT 4.1 DVD > Projects_ HDL > EPT_10MO4_AF_Blinky > src Sear
@ New Tl Sort = View
> ESP32_DJ_SNACK_PACK_PROJECT_4.0_DVD [ _Name Date modified Type Siz
~ MAXPROLOGIC_FPGA_PROJECT 4.1_DVD -_‘.' EPT_10MOQ4_AF_52_Top.v 4/3/2018 352 PM W File

Documentation

> Drivers
~ 7 Prajects HDL
~  © EPT_10M04 AF Blinky
» EPT_10M04_AF S2 Top

ModelSim
sim
src
test
Testbench

> EPT_10MO4_AF_Control_Statements |

Then navigate to your local proejct window. C:\Users\<Your PC>\Documents. Create a new
folder called ““src”. Paste the “EPT 10M04 AF S2 Top.v” file into the new “src” folder.

& g 9] l:l > ThisPC > Windows(C:) > Users > nelso > Documents > EPT_10MO4_AF Blinky > EPT_10MO4_AF_S2_Top > Search EPT_1
@ New *» O ()] ) L sort = View
> . Cookies O Name -

Date modified

~ © Documents 4/6/2025 2:36 PM

> EPT_4CEG_AF_Platform_Demo

v EPT_10CLO16_AF System_Demo
> EPT_10CLOTE_AF T2 Top
sre
v EPT_10MO4_AF_Blinky
> EPT_10MO4_AF_S2_Top

> My Music

> My Pictures
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&« T C J > ThisPC > Windows(C) > Users > nelso > Documents > EPT_1OMO4_AF Blinky > EPT_10MO4_AFS2Top > sric
@ New o T Sort = View
> Cookies O Name Date modified Type
~ Documents ‘_;’ EPT_10MO04_AF 52 Top.w 4/3/2018 %:32 PM V File
> EPT_4CE6_AF_Platform_Demo

EPT_10CLO16_AF_System_Demo
> EPT_10CLD16_AF_T2_Top
src
EPT_10MO4_AF_Blinky
EPT_10MO4_AF_S2_Top

src

> My Music

At the Add Files window, select the directory navigation button.
(G New Project Wizard

X
Add Files
Select the design files you want to include in the project. Click Add All to add all
design files in the project directory to the project.
Note: you can always add design files to the project later.
File name: I:l Add
. ¢ | Add All
File Name Type Library Design Entry/Synthesis Tool HDL Version = Remove
Up
Down
Specify the path names of any non-default libraries. User Libraries... Properties
Help < Back| MNext>| Finish Cancel
d

At the Add Files window: Browse to the $\MAXPROLOGIC FPGA PROJECT 4.x DVD

\Projects HDL\EPT 10M04 AF Blinky \src folder of the EPT USB-FPGA Development
System CD. Copy the files from the \src directory.

e EPT 10M04 AF S2 Top.v
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o O newp

Add Files

Select the design files you want to include in the project. Click Add All to add all design files in the project directory to the project.

Note you can always add design files to the project later

A Elename
Add All
LN b |
v File Name Type Library Design Entry/Synthesis Tool HDL Version
Select File X =
< v o < EPT_10MO4_AF Blinky > EPT_10MO4_AF_S2.Top > src v P
Organize New folder =~ IO 0
> Cookies O Name -
~ . Documents EPT_10MO4_AF_S2_Topav
> EPT_4CE6_AF_Platform_Demeo
> EPT_10CLO16_AF System_Demo
~ T EPT_10MO4_AF Blinky
~ T EPT_10MO4_AF_S2_Top
st
> My Music
5 > My Pictures
> My Videos

> Visual Studic 2019

sh Cancel
| File name: | EPT_10M04_AF_52_Top.v Design Files (*df *vhd *whdl * ~ E
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| G Mew Project Wizard

Add Files

Select the design files you want to include in the project. Click Add All to add all design files in the project directory to the project

Note: you can always add design files to the project later.

Eile name:

|
Add Al
) 3
Remove
File Name Type Library Design Entry/Synthesis Tool HD:
sro/EPT_10M04_AF_S2_Top.v Verilog HDL File Det Up
Dowr
Propertie:
1 G
Specify the path names of any non-default libraries. | User Libraries...
< Back MNext > FEinish Cancel

Help

Select Next, at the Device Family group, select MAX 10 for Family.
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| G Mew Project Wizard
Family, Device & Board Settings

Device Board

Select the family and device you want to target for compilation

You can install additional device support with the Install Devices command on the Tools menu.

| To determine the version of the Quartus Prime software in which your target device is supported, refer to the Device Support List webpage.

Device family

Family: | MAX 10 (DA/DD/DF/DC/SA{SC/SL)

Device:  All

Target device

Specific device selected in "Available devices' list

Available devices:

Name Core Voltage LEs
10MOBDAF256C8GES | 1.2V 8064 178
10MOBDAF256I7G 1.2v 8064 178
10MOBDAF484C8G 1.2v 8064 250
ANMNANACARAC ACES |1 27 anEa | ?E0

Help

Total I/0s

GPIOs

178

178

Memory Bits

387072

387072

387072

2/INT?

Show in "Available devices' list

Package: Any
Pin count Any
Core speed grade: | Any

Name filter:

V' Show advanced devices

Embedded multiplier 9-bit elements PLLs Global Clocks
ag 2 10
ag 2 10
48 2 10
as 2 n
< Back Mext >

In the Available Devices group, browse down to 10M04SAE144C8 for Name.
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| 38 New Project Wizard
Family, Device & Board Settings

Device Board

Select the family and device you want to target for compilation
‘You can install additional device support with the Install Devices command on the Tools menu.

| To determine the version of the Quartus Prime software in which your target device is supported, refer to the Device Support List webpage.

Device family Show in "Available devices' list
Eamily: | MAX 10 [DA/DD/DF/DC/SA/SC/SL) - e o N
Device: | MAX 10 5A ¥ Pin count Any .
Target device Core speed grade: | Any -
Auto device selected by the Fitter Name filter
0

Specific device selected in "Available devices' list V' Show advanced devices

Other: nfa

Available devices:

Name Core Voltage LEs Total I/0s GPIOs Memory Bits Embedded multiplier 9-bit elements PLLs Global Clocks Maximum User
T0MO4SAET44AT7G 3.3V 4032 101 101 193536 40 1 1o 2424832
e Y O
10MO4SAET44I7G 3.3V 4032 101 101 193536 40 1 1o 2424832
‘:nMn.ﬂCAM‘!:'-!FQC 2 AN32 112 112 103834 A al an 2424R32 T i
Help < Back Mext > Einish Cancel

Click the “Next” button.
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| G Mew Project Wizard

EDA Tool Settings

Specify the other EDA tools used with the Quartus Prime software to develop your project.

EDA tools:
Tool Type Tool Name Format(s) Run Tool Automatically
| | Design Entry/Synthesis <None> v | <None> Run this tool automatically to synthesize the cur
Simulation Questa Intel FPGA ~ || Verilog HDL s Run gate-level simulation automatically after con
Board-Level Timing <None> v
Symbol <None> b
Signal Integrity <None> hd
Boundary Scan <None>
1 G
Help < Back Mext > Einish Cancel

Select Next, leave defaults for the EDA Tool Settings.

Page

90



@ !EAR1;HPE|OPLE
& B n o o g

MaxProLogic Development System User Manual

O New Project Wizard X

Summary

‘when you click Finish, the project will be created with the following settings

Project directory:
Project name:
Top-level design entity:
Number of files added:
Number of user libraries added:
Device assignments
Design template:
Family name:
Device:
Board
EDA tools:
Design entry/synthesis:
Simulation
Timing analysis:

Operating conditions:

C:\Users\nelso\Documents\EPT_10M04_AF_Blinky\EPT_10MD4_AF_S2_Top

EPT_10M04_AF_S2_Top
EPT_10M04_AF_S52_Top
3
0

nfa
MAX 10 (DA/DDYDF/DC/SA/SC/SL)
TOMO4SAET144C8G

nfa

<None> (<None>)
Questa Intel FPGA (Verilog HDL)
0

Core voltage: 3.3v
Junction temperature range: 0-85 €C
Help < Back Mext > Finish Cancel

Select Next, then select Finish. You are done with the project level selections.

Next, we will select the pins and synthesize the project.

6.1.1 Selecting Pins and Synthesizing

With the project created, we need to assign pins to the project. The signals defined in the top
level file (in this case: EPT_10M04 AF S2 Top.v) will connect directly to pins on the FPGA.
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The Pin Planner Tool from Quartus Prime Lite will add the pins and check to verify that our pin

selections do not violate any restrictions of the device. In the case of this example we will import
pin assignments that created at an earlier time.

Go to Quartus Prime Lite start window. Then select File->Open Project
(h Quartus Prime Lite Edition - Ci/Users/nelso/Documents/EPT_10MO4_AF_Blinky/EPT_10MO4_AF_S2_Top/EPT_10MO4_AF_52_Top - EPT_10MO04_AF_52_Top

J30 Edit View Project Assignments Processing Tools Window Help

[ New... Ctrl+N
w0 |0 s | /G EQ D> b 5@ O
Close Ctrl+F4

ewr Proje - IP Catalog
New Proiect vizz e@es .

C—
Sawve Project

- 1‘ Installe:

Close Project = ¥ Project

H save Ctrl+5 No &

Save As... ¥ Library

&P save All Ctrl+Shift+s b Basi

Eile Properties...

L3
B ] 3

S ' O uartus Primejgs
Export,.. | =@ ®E N
1 Lit 4

Convert Programming Files...

5i0 Li o Univ
Task =

¥ Buy Software © searcn:

i Page Sefup...

@ Print Preview

B print... Ctrl+P
Recent Files ¥ les) .’I' + add
Recent Projects L4
Exit AlteFa J | #cing... ||“FindNa§l‘
) o e — =
- Type ) Message
) 253020 pefault device 10MOBDAF484CEG 15 automatically selected for the device family max 10

Navigate to the project created in previous section.

Page
92




@ !EAR1;HPE|OPLE
& B n o o g

MaxProLogic Development System User Manual

| Open Project X

I » richard jolly > Documents > EPT_TOMO4_AF_Blinky > EPT_10MO4_AF_S2_Top » w (&} Search EPT_10M04_AF 52 T.. 0°
Organize v Mew folder =~ O o
> ] Documents Name - Date modified
v Documents db
y EPT_4CE6_AF_Platform_Demo (3 EPT_10MO4 AF 52 Top.qpf
> EPT_10CLO16_AF_System_Demo

> EPT_10MO04_AF _Blinky |

I > My Music |

> . MyPictures
> My Videos

> Visual Studic 2019

>+ Downloads

bl Favorites

File name: v| Quartus Prime Project File (*.qp ~

Cance)

Select “Open”. The Quartus Window will be set up with the selected project.
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|8 et Frimes Line Exbtion - CulisersieloaDoosmert/ERT_10WAM_AF_BivkyEFT_IOMID_AF 52 TopEFT_ 10, AF 52, Top - EFT_10MB_AF 52 Top
e [d% \ew Eroject Suignmees Foceesng Jock yindow Hep

| = H o+~ t D¢ e o S 66@ IE [ ‘ﬁo e = “,‘ L]

= o *
L
LIET

% | B

L
Progect Navigator o Hararchy - G0@ K
LY
Enbtyiratin
A MAK 10 VDMOHSAZ] S4CBG =l i
* EPT_T0MC4_AF_SZ_Top & = Projess Dirssary
= Libery
+ Basie Fumetions
e
= b irmerface Prooocs
Quartus Prim el
Tashs. Complaen rmd@® * Frocssson and Pariphacals
! b Unkeiy
— = Fragram
| B seanntor Fanre B
= I Compde Cesign
b anubyain & Synthen
v P Fime Pace 8 Rte
Iy b P sspeminks IGATETNE DIORRAMTIG W) = + a
|8
F; | (A& |~ v e 4 MEnd | B Fed byt
Type ™ vmnsage
0 53020 pefauTe device 10mbECarddscEc 15 avtomarically selecred Tor the devics TamiTy wax 10

&

§| spami | Pecessng

Under Assignments, Select Import Assignments.
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Gk Quartus Prime Lite Edition - C:/Users/nelso/Documents/EPT_10MO4_AF_Blinky/EPT_10MO04_AF_S2_Top/EPT_10MO04_AF_S2_Top - EPT_10M04_AF_S2_Top

File Edit View Project Processing Tools Window Help

O d ¢

Project Navigator

4% MAX 10: TOMO4SAE144C

* EPT_10MO4_AF_S2_T|

?J Device...
Ctri+Shift+E
6 Assignment Editor Ctr+Shift+A
6 Pin Planner Ctrl+Shift+N
Remove Assignments.
Back-Annotate Assignments
| Impert Assignments. I

Export Assignments

Assignment Groups..
8 Logic Lock Regions Window Alt+L

Alt+D

" Design Partitions

Top bt

Quartus Prime

/GEO Dr b5 QaD]

IP Catalog
IS
* g Installed IP
~ Project Directory
Mo Selection Availa
= Library
¥ Basic Functions

b DsP

b Interface Protocols

¥ Memory Interfaces .
Tasks Compilation r|Eta® } Processors and Per
a ¥ University Program
Task
. Search for Partner IP
~ P Compile Design
b P Analysis & Synthesis
» P Fitter (Place & Route)
7 » P Assembler (Generate proerammine files) .’.' + add.
e —
I\ All ‘OHAHi‘ ‘h‘ ‘ ¥ <<Filters> J | Mrind ||“FmdMe§l‘
- Type ) Message
) 253020 pefault device 10MOSDAF4B84CEG is automatically selected for the device family mMax 10

At the Import Assignment dialog box, Browse to the
$\MAXPROLOGIC FPGA PROJECT 4.x DVD \Projects HDL\EPT 10M04 AF Blinky \
EPT 10M04 AF S2 Top folder of the EPT FPGA Development System DVD. Select the

“EPT_10M04_AF S2 Top.qgsf” file.
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| Select File x

€ v o <« MAXPROLOGIC_FPGA_PROJECT_4.1.DVD > Projects HDL » EPT_10MO4_AF Blinky » EPT_10MQ4_AF_S2_Top v & Search EPT_10MO4_AF 52 T.. @
Organize v New folder =~ 0O 0
S
> Drivers Name Date modified
v Projects_HDL db 4
v 7 EPT_10MO4_AF Blinky incremental_db
output_files
> EPT_10MO4_AF_S2 Top |
simulation
| ModelSim
I EPT_10MO04_AF_52 Top.qgsf
|
| sim |
src
test
Testbench
> EPT_10M04_AF_Control_Statements
b EPT_10MOD4_AF_Flip_Flop
File name: | Import Files (*.qsf *.esf *.acf *.c
13 2
Select “Open”.
i_h Impaort Assignments *

Specify the source and categories of assignments to import.

| Eilename: [ 4.1 _DVD/Projects HDL/EPT_10M04 AF_Blinky/EPT_10M04 AF S2 Top/EPT_10M0O4 AF S2 Top.gsf| | .. Categories... | |
V| Copy existing assignments into EPT_10M04_AF_S2_Top.qsf.bak before importing Advanced...
oK Cancel Help

Click Ok. Under Assignments, Select Pin Planner. Verify the pins have been imported correctly.
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B Quartus Prime Lite Edition - C:/Users/nelso/Documents/EPT_10MO4_AF_Blinky/EPT_10M04_AF_S2_Top/EPT_10MO4_AF_S2_Top - EPT_10MO4_AF_52_Top

Eile Edit View Project Processing Tools Window Help

Ctrl+Shift+E
D4 ¢ e | OCOTr S EOOLEOE
6 Assignment Editor Ctrl+shift+A
| 4% pin Planner | Ctrl+Shift+N IP Catalog
Project Navigator
Remove Assignments ‘ o

r"y Back-Annotate Assignments... S -
< G Installed IP

~ Project Directory

#% MAX 10: TOMO4SAE144C

Import Assignments...
* EPT_10MD4_AF_52_T

Export Assignments, No Selection Available

Assignment Groups * Library

Basic Functions

ﬂ Logic Lock Regions Window Alt+L
} DSP

Alt+D

Interface Protocols

Memory Interfaces and Contre

Quartus Prime

on

Tasks Compilation

Processors and Peripherals

University Program
Task

. Search for Partner IP
~ P compile Design ‘w Buy Software

b P Analysis & Synthesis %

» P Fitter [Place & Route) 5

b P Assembler (Generate programmine files) b + Add

Al ‘0‘ ‘A‘ ‘A‘ ‘N‘ ‘ ¥ <<Filters> J ‘ uEmd... | ‘uFmdNe;l |
Type o Message
) 253020 pefault device 10MOBDAF484C8G 1s automatically selected for the device family MAX 10
o 140120 Import completed. 26 assignments were written (out of 53 read). O non-global assignments were skipped because of entit
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The pin locations should not need to be changed for EPT FPGA Development System. However,
if you need to change any pin location, just click on the “location” column for the particular node
you wish to change. Then, select the new pin location from the drop down box.

6 Pin Planner - Ci/Users/nelso/Documents/EPT_10MO4_AF_Blinky/EPT_10MO4_AF 52 Top/EPT_10MO4_AF 52 Top - EPT_10M04_AF 52 Top - (] X
Eile Edit View Processing Tools Window Help ),_H rch Intel EPGA e |
— | Groups 1@ I AU, — Pin Legend 1@ &=
o LR : Sl el G A =
B | Named: * = . Symbol Fin Type
| Node Name Direction Locati : W User |/
| k <SSNEW groups> Top View - . Userassigned I/...
| q - . Fitter assigned |
| - Wire Bond, with Exposed Pad 3 @ Unbonded pad
w E i . Reserved pin
il ‘.;I Other
:Ii A » (€] DEV_OE
Groups | Report 3 (") DEV_CIR
o o DIFF_n
Tasks 1E® - MAX 10 §
H ® DIFF_p
- Early Pin Planning E [ s
B ety Fin Plani A 10MO4SAE144C8G Fl== CLk.n
- arly Pin Planning... ol cup
HIE P Run I/O Assignment Analysis - I !' Other BLL
(e B Export Pin Assignments S — — — _ 5) Other dual
-I\Ifl_ B Fin Finder . A e el e 0 ol -
IEI ®  Named, * ¥ | «» | Edit Filter, Pins: all e
n MNode Name Direction Location IO Bank VREF Group IO Standard Reserved Current Strength Slew Rate Differential Pair |Strict PrES_
| € Lepio] Unknown PIN_21 1B B1_NO 3.3-V LVTTL 8mA (default)
| = 0 LED[1] Unknown PIN_22 1B B1_NO 3.3-V LVTTL 8mA (default)
| ¥ Lepl2] Unknown PIN_24 1B B1_NO 3.3-V LVTTL 8mA (default)
0 LED[3] Unknown PIN_25 1B B1_NO 3.3-VLVTTL 8maA (default)
H F;: © cuk_32KHZ Unknown PIN_27 2 B2_NO 3.3V LVTTL BmA (default)
| - e CLK_32KHZ_ENABLE Unknown PIN_30 2 B2_NO 3.3-V LVTTL 8maA (default)
| | © e Unknawn 33-V LVTTL BmA (default)
u € LeDla] Unknown PIN_32 2 BZ_NO 2.5 V (default) 12mA (default)
: (D 0 LED[5] Unknown PIN_33 2 B2_NO 2.5V (default) 12mA (default)
[ ] © Lene] Unknown PIN_38 3 B3_NO 2.5V (default) 12mA [default)
& 0 LED[7] Unknown PIN_39 3 B3_NO 2.5V (default) 12mA (default)
0 PWR_ENABLE Unknown PIN_141 8 Ba_NO 2.5V (default) 12maA (default)
= € cLk_somHzZ Unknown PIN_26 2 B2_NO 3.3-V LVTTL 8mA (default)
2] 4 CLK_50MHZ_ENABLE  Unknown PIN_17 1B B1_NO 3.3-V LVTTL 8mA (default)
*_
i <snew node>>
10
| .-
»io
»-
P
| =
[
2l >
L 0% 00:00:00 ]

Exit the Pin Planner. Next, we need to add the Synopsys Design Constraint file. This file
contains timing constraints which forces the built in tool called TimeQuest Timing Analyzer to
analyze the path of the synthesized HDL code with setup and hold times of the internal registers.
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It takes note of any path that may be too long to appropriately meet the timing qualifications. For
more information on TimeQuest Timing Analyzer, see

http://www.altera.com/literature/hb/qts/qts_qii53018.pdf?GSA pos=1&WT.oss r=1&WT.oss=T
imeQuest Timing Analyzer

Browse to the $\MAXPROLOGIC FPGA PROJECT 4.x DVD

\Projects HDL\EPT 10M04 AF Blinky \ EPT 10M04 AF S2 Top folder of the EPT USB-

FPGA Development System CD. Select the “EPT 10M04 AF S2 Top.sdc” file.
Ba—

@\_/' K 5 Prodicty » Eath People Technology » s BT uss CPLO Deveopment Sstem CD » ProjectsHOL » EPT_Tan sle Tet s A EPNSTL2 » v 4
e s e

Copy the file and browse to c:\altera\xxx\quartus\qdesigns\EPT 10M04 AF Blinky directory.
Paste the file.

cway (C) » alters » 121spl » quartus » qdesigns » EPT_Transfer Test »

New folder

op.jdi
@ EPT_570_AP_U2_Top.qpf
[ EPT_570.AP_U2 Top.qsf
EPT_570_AP_U2 Top.qsf.bak 5
| EPT_5T0_AP_U2 Top.sdc 1/29/201310:30 PM  SDC File 4KB

CIMTEMP
A Document ts and Settings

d: 1/29/20131030 PM Date created: 3/13/2013 9:41 PM
316 KB

EPT_570_AP_U2 Top.sdc Date
SDC File

Select the Start Compilation button.
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| G Quartus Prime Lite Edition - C/Usersnelso/Doeuments/EPT_10MO4_AF Blinky/EPT_10MO4_AF_S2_Top/EPT_10MO4_AF_S2 Top - EFT_10MO4_AF S2_Top

Ele Edit View Project Assignments Processing Tools Window Help

DEE~00 »C

EPT_10M04_AF_S52_Top >

/SO TPt o CAVE

IP Catalog
Project Navigator A\ Hierarchy
L& % |
2% MAX 10: 10MO4SAE144CEG < installed 12
@ EPT_10MO4_AF_S2_Top &  Project Directory
No Selection Available
* Library
» Basic Functions
» psp
¥ Interface Protocols
» Memory Interfaces and Controllers
Tasks Compilation » Processors and Peripherals
— » University Program
Task
@ search for Partner P
~ P compile Design
b P Analysis & Synthesis
b P Fitter (Place & Route)

b P Assembler (Generate rogrammine files)
0 5 + add
Al ‘OHAH! ‘»\‘ ‘ <<Filters> J | 88End. || 88rindnes
Type D Message

[} 253020 pefault device 10MOSDAF484C8G 15 automatically selected for the device family MAX 10
e 140120 Import completed. 26 assignments were written (out of 53 read). 0 non-global assignments were skipped because of entity name mismatch.
o 21648 Please refer to Package outline Drawing (POD) for any mechanical enablement at https://www.intel.com/content/waw/us/en/programmable/support/literature/1it-index/1it-pkg. html.

“

Messages

System (3) | Processing

0%  00:00.00

During compilation, the window will show this screen:
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(3 Quartus Prime Lite Edition - C/Users/nelse/Documents/EPT_10MO4_AF_Blinky/EPT_10M04_AF_S2_Top/EPT_10MO4_AF_S2_Top - EPT_10MO4_AF 52 Top

Eille Edit View Project Assignments Processing Tools Window Help

OfFd T

roject Navigator A\ Hierarchy rale®

Entity:Instance
i) MAX 10: 10MO4SAE144C86
® EPT_10MO4_AF_S2_Top ‘B

0 0

/GCOD>+-.SQOLOHE 9

& Compilation Report - EFT_10M04_AF_52_Top X

Table of Contents
B2 Flow Summary
E= Flow Settings
E Flow Non-Default Global Settings
E Flow Elapsed Time
F= Flow 05 Summary
El FlowLog

+ B Analysis & Synthesis

ve [T

@ ccr

Flow Status

Quartus Frime Versio
Revision Name
Top-level Entity Nam
Farmily

Device

Timing Models

1P Catalog

Intel FPGA

x

,
Fitter Total logic elements
asks =Mae | M Asemblr Total registers
» I8 Power Analyzer Total pins
Task = O Flow Messages Total virtual pins
Search for Partner
ﬁ, - P c © Flow Suppressed Messages Total memory bits
R p— Embedded Multiplier
Total PLLs
, tter (Place & Route)
Fitter (Place & Route) UFM blocks
» P Assembler (Generate oroerammine files) - PC hincke
] = ¥4 v
2 s =
Dl O A4 (A 88Eind.. | |88Find Next
g
Type i) Message
v A 332060 Node: CLK_5OMHZ was determined to be a clock but was found without an associated clock assignment.

223001 completed vectorless P

er Acti

334003 started post-fitting delay annotation
334004 Delay annotation completed successfully

Messages

System (3) | Processing (119)

332061 virtual clock CLK_50MHZ is never referenced in any input or output delay assignment.
223000 starting vectorless Power Activity Estimation
222013 Relative toggle rates could not be calculated because no clock domain could be identified for some nodes
ty Estimation
218000 Using Advanced I/0 Power to simulate I/0 buffers with the specified board trace model

After successful completion, the screen should look like the following:
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OMO4_AF S52_Top - EPT_10MO4_AF S2 Top - o

Search Intel FPGA [ ]

D Quartus Prime Lite Edition - Cy/Users/nelso/Doc:

D ~ D .‘ EPT_10MO4_AF_S2_Top | £ 9 ¢ @ > > (A O e i!i » # ,

la & Compilation Report - EPT_10M04_AF_S2_ Top X IP Catalog 1@®
roject Navigator A Hierarchy co@e® ompilation Repor C :_AF_S2_Top
Table of Contents EYEW F low summary « X | =
Emtity Instance EH Flow summary & <<Filier>> =
M Installed IP
% MAX 10: T0MO4SAE144C8G FH Flow Settings Flow Status
B2 .
T EPT_10MO4 AF_S2_Top '™ FE Flow Mon-Default Global Settings Quartus Frime Versio
B Flow Elapsed Time Revision Name
B Flow 05 Summary Top-level Entity Nam
Family
E FlowLog
Device * D5P
b I Analysis & Synthesis
Timing Models » Interface Protocols
» Fitter 1 I
R (MRl EF =T b Memory Interfaces and Controllers
asks Compilation -=les Total registers
,
Total pins .
Task ’
) @ scarch forPartner Ip
Flow Messages Embedded Multplier
& P
© Flow Suppressed Messages Total PLLs
UFM blocks
ADC hlncks e .
¥ [« 0 + Add..
2 )
Dllan| (©|A|4 (A Filters> 88Eind. | 88 Find Next
q
B Type ) Message r~

o
© A AT AT SRS
o RUNNing Quartus Prime EDA Netlist writer
o Command: quartus_eda --read_settings_files=off —-write_settings_files=off EPT_10MO4_AF_S2_Top -c EPT_LOMO4_AF_S2_Top

18236 Number of processors has not been specified which may cause overloading on shared machines. set the global assignment NUM_PARALLEL_PROCESSORS in your QSF to an appropriate
) 204019 Generated file EPT_10MO4_AF_S2_Top.vo in folder "C:/users/nelso/Documents/EPT_LOMO4_AF_&1inky/ERT_LOMO4_AF_S2_Top/simulation/questa/” for EDA simulation tool
o Quartus Prime EDA Netlist writer was successful. 0 errors, 1 warning
o 293000 quartus prime Full Compilation was successful. 0 errors, 63 warnings

100% __00.00:31

Messages

System (3) | Processing (171)

At this point the project has been successfully compiled, synthesized and a programming file has
been produce. See the next section on how to program the FPGA.

7 Programming the MaxProLogic
o Please Note: The MaxProLogic Does Not Contain On Board
Programmer. JTAG Programming and Configuration Flash
Programming must be performed by external Programmer Purchased
Separately.

Configuring the FPGA is quick and easy. All that is required is a standard USB-C cable and a
compatible Blaster Programmer. Connect the MaxProLogic to the PC, open up Quartus Prime
Lite, open the programmer tool, and click the Start button. To program the MAX10
Configuration Flash, connect the Blaster and ensure the JTAG Driver is loaded for Quartus
Prime Lite.
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If the project created in the previous sections is not open, open it. Click on the Programmer

button.

(S Quartus Prime Lite Edition - CfUsers/nelso/Documents/EPT_10M04_AF_Blinky/EPT_10M04_AF_S2_Top/EPT_10MO04_AF_S2_Top - EPT_10MO4_AF 52 Top

File Edit View Project

Or=d

Assignments

Processing  Tools

]

Window  Help

EPT_10MO4_AF_52_Top

X

>roject Navigator #% Hierarchy v Q@@
Table of Contents
EntityInstance B8 Flow Summary
&% MAX 10: 10MO45SAE144C8G B Flow Settings
[2b:c]
T EPT_10MD4_AF_52_Top & B Flow Non-Default Global Settings
B Flow Elapsed Time
B Flow os summary
E FlowLog
T =i Analysis & Synthesis
4 Fitter
Assembler
Tasks Compilation ~ | =1E®
Power Analyzer
Task = 3 Timing Analyzer
= P Complile Design r EDA Netlist Writer
* P Analysis & Synthesis O Flow Messages
O Flow Suppressed Messages
b P Fitter (Place & Route) PP =8
» P Assembler (Generate proerammine files) b
L » 4
® o &
Al D[ A4 N <<Filters> ®8Find.. | MBFind Next
~ Type i) Message
» Quartus Prime Timing Analyzer was successful. O errors, warnings

runnina Nuarrus prima £Fna Netlist writer

Page

> >

& Compilation Report - EPT_10M04_AF_S2_Top X

3o TR | o
® <<Filter>>

Flow Status

Quartus Prime Versio
Revision Name
Top-level Entity Nam
Family

Device

Timing Models

Total logic elements
Total registers
Total pins

Total virtual pins
Total memory bits
Embedded Multiplier
Total PLLs

UFM blocks

ADC hlacks

‘

@ © 4

IP Catalog

Dt 9

o

+ @ Installed P
* Project Directory

No Selection Available

~ Library

Basic Functions

DsP

Interface Protocols

Memory Interfaces and Controllers
Processors and Peripherals

University Program

@ search for Partner 1P

+ Add.
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The Programmer Window will open up with the programming file selected. Click on the

Hardware Setup button in the upper left corner.

0 Programmer - [Chain.cdf]

Eile Edit Wiew Processing Tools Window Help

; Hardware Setup... PT-JTAG-EBlaster v1.0 (64) [MBUSE-0] Mode: | JTAG

Enable real-time ISP to allow background programming when available

File Device Checksum Usercode Program/  Verify = Blank-
Configure Check

M auto Detect
Delete
" Add File
¢ Change File 1

A save File

* Add Device...
T

s Down

= Progress: l

Examine  Security Erase ®ac ISP 'SFi{PF
Bit acks CLAMP

The Hardware Setup Window will open. In the “Available hardware items”, double click on

“EPT-JTAG-Blaster v1.0b (64)”.
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- é Hardware Setup

Hardware Settings JTAG Settings

Select a programming hardware setup to use when programming devices. This programming

hardware setup applies only to the current programmer window.

Currently selected hardware: | EPT-JTAG-EBlaster v1.0 (64) [MBLUSE-0]

Hardware frequency:

Available hardware items

Har Server Port

EPT-JTAG-EBlaster v1.0 (64) )al MBEUSE-O

Hz

Add Hardware. .

Remove Hardware

Close

If you successfully double clicked, the “Currently selected hardware:” dropdown box will show

the “EPT-JTAG-Blaster v1.0b (64)”.
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- é Hardware Setup

Hardware Settings JTAG Settings

Select a programming hardware setup to use when programming devices. This programming

hardware setup applies only to the current programmer window.

Currently selected hardwa@-JTﬂG-Blaster v1.0 (64) [MBUSB-D -

Hardware frequency:

Available hardware items

Hardware

EPT-JTAG-Blaster v1.0 (64)

Click on the “Add File” button

Server

Local
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a Programmer - [Chainl.cdf] = O =

Eile Edit View Processing Tools Window Help

; Hardware Setup... | |EPT-JTAG-Blaster v1.0 (64) [MBUSB-0] Mode: | JTAG v Progress:

Enable real-time ISP to allow background programming when available

File Device Checksum Usercode Program/ = Verify = Blank- Examine | Security Erase Reac ISP 'S Fi{PF
Configure Check Bit :cks CLAMP
%S’.:p
»
* Add Device...
%I_\:
Y
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a Select New Programming File

Look in: C:\Users\nelso\Documents\EPT_10M04_AF_Blinky\EPT_10M04_AF_S52_Top - Q@ 0 ©
Z My Computer Name
nelso db

simulation

| File name: |

| Files of type: | Programming Files (*.sof *.pof * jam *.jbc *.ekp * jic)

@ E E

Open

Cancel

At the Browse window, double click on the output files folder.
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| 0 Select New Programming File

Look in: C:\Users\nelso\Documents\EPT_10M04_AF_Blinky\EPT_10M04_AF_52_Top\output_files
Z My Computer L
| nelso [ | EPT_10M04_AF_S2_Top.pof |
| T EPT_TOMOZ AF 52 10pso
1
File name:

Files of type: | Programming Files (*.sof *.pof * jam *.jbc *.ekp * jic)

Q

o @ H B

Open

v Cancel

Double click on the “EPT _10M04 AF S2 Top.pof” file. Click the Open button in the lower

right corner.
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» Pragrammer - Ci/Users/nelso/Documents/EPT_10MO4_AF_Blinky/EPT_10MO4_AF_S2_Top/EPT_10MO4_AF_S2_Top - EPT_10MO4_AF_S2_Top... = O x
Eile Edit View Processing Tools Window Help Search Intel FPGA e
:. Hardware Setup... | |[EPT-JTAG-Blaster v1.0 (64) [MBUSE-0] Mode: | JTAG b Progress:

Enable real-time ISP to allow background programming when available

Ny File Device Checksum Usercade Program/ = Verify = Blank- Examine  Security = Erase
Start i
e Configure Check Bit
i Stop output_files/EFT_10M... | 10MD4SAE144 0266F941 0008DEG2
CFMO
8 Auto Detect UEM | | | | | |
X Delete

[ | P addFile...

1 3

Fec hange File...

b save File

, .Add Device... TDI

=
=
....l....

Jown EEEEEEEER

TRSMO4SAE14

Next, selet the checkbox under the “Program/Configure” of the Programmer Tool.
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» Pragrammer - Ci/Users/nelso/Documents/EPT_10MO4_AF_Blinky/EPT_10MO4_AF_S2_Top/EPT_10MO4_AF_S2_Top - EPT_10MO4_AF_S2_Top... = O x
Eile Edit View Processing Tools Window Help Search Intel FPGA e
:. Hardware Setup... | |[EPT-JTAG-Blaster v1.0 (64) [MBUSE-0] Mode: | JTAG b Progress:

Enable real-time ISP to allow background programming when available

pls File Device Checksum Usercade Program/ = Verify = Blank- Examine  Security = Erase
Slai Configure Check Bit '
thgiop output_files/EPT_10M.. 10MO4SAE144 0266F941  DDDBDE6Z v
CFMO v
& Auto Detect
X Delete
" Add File...

Fec hange File...

b save File

, .Add Device... TDI

=
=
lllllllll
-

Jown EEEEEEEER

TRSMO4SAE14

Click on the Start button to to start programming the FPGA.
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» Pragrammer - Ci/Users/nelso/Documents/EPT_10MO4_AF_Blinky/EPT_10MO4_AF_S2_Top/EPT_10MO4_AF_S2_Top - EPT_10MO4_AF_S2_Top... = O x
Eile Edit View Processing Tools Window Help Search Intel FPGA e
:. Hardware Setup... | |[EPT-JTAG-Blaster v1.0 (64) [MBUSE-0] Mode: | JTAG b Progress:

Enable real-time ISP to allow background programming when available

pls File Device Checksum Usercade Program/ = Verify = Blank- Examine  Security = Erase
Shat Configure Check Bit I
thgiop output_files/EPT_10M... 10MD4SAE144 0266F341  DDDBDEG2 v
CFMO v
) Auto Detect T ] ] ] ] ]
X Delete
[ | P addFile...
1 3

Fec hange File...

b save File

, .Add Device... TDI

=
=
lllllllll
-

Jown EEEEEEEER

TRSMO4SAE14

The Progress bar will indicate the progress of programming.
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» Pragrammer - Ci/Users/nelso/Documents/EPT_10M04_AF_Blinky/EPT_10M04_AF 52 _Top/EPT_10MO4_AF S2 Top - EPT_10MO4_AF_S2_Top... = O *
Eile Edit WView Processing Tools Window Help search Intel FPGA e
_E,, (BTG TENRT= s Wl F P T- I TAG-Elaster v1.0 (64) [MBUSE-0] Mode: | JTAG Progress: [ I 16%

Enable real-time ISP to allow background programming when available

it

%W File Device Checksum Usercode Program/ | Verify | Blank- Examine | Security | Erase
Start i 5
e Configure Check Bit
il Stap output_files/EPT_10M.. T0OMO4SAET144 0266F947 00080EGE2 v
CFMO v
ﬂfau to Detect UFM . . . . .
Delete
M Add File. I

e Change File... |
2 save File

* Add Device... TD I

W"L,p E—

EEEEEEEEE
e
EEEEEEEEE

%Escwn [LLLLLLLL]

4TEI§M 04SAE14

When the programming is complete, the Progress bar will indicate success.
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» Pragrammer - Ci/Users/nelso/Documents/EPT_10MO4_AF_Blinky/EPT_10MO4_AF_S2_Top/EPT_10MO4_AF_S2_Top - EPT_10MO4_AF_S2_Top... = O x

Eile Edit View Processing Tools Window Help Search Intel FPGA e,

:. =l TR VI PT- /T AG-Blaster v1.0 (64) [MBUSE-0] Mode: | JTAG b Progress: 100% (Successful)

Enable real-time ISP to allow background programming when available

pls File Device Checksum Usercade Program/ = Verify = Blank- Examine  Security = Erase
ST Configure Check Bit I
i Stop output_files/EFT_10M... 10MO4SAE144 0266F941 0008DE&2 v
CFMO v
w}\uto Detect UEM v
X Delete
[ | P addFile...
P Change File... L L
1 save File
| [/ Add Device ssssummns
| . u
; TDI :
H H
byp — b :
| H H
I %[1:3-.'.1" .uuu-u.

TPEMO4SAE14

At this point, the MaxProLogic is programmed and ready for use.

The eight LEDs on the front of the MAXPROLOGIC will blink one after the other.
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Alternatively, the user can program the MAX10 FPGA using the *.sof programming file. This

method programs the FPGA using the JTAG connections. However, the programming file is
NOT loaded into the on chip Flash. Instead, the programming file is loaded directly into the

FPGA's SRAM, thereby configuring it. SOF files are used for direct, volatile configuration,
meaning the FPGA configuration is lost when power is removed.

To program the MAX10 using SOF file, connect the Blaster and ensure the JTAG Driver is

loaded for Quartus Prime Lite.
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If the project created in the previous sections is not open, open it. Click on the Programmer

button.

(S Quartus Prime Lite Edition - CfUsers/nelso/Documents/EPT_10M04_AF_Blinky/EPT_10M04_AF_S2_Top/EPT_10MO04_AF_S2_Top - EPT_10MO4_AF 52 Top

File Edit View Project

Or=d

Assignments

Processing  Tools

]

Window  Help

EPT_10MO4_AF_52_Top

X

>roject Navigator #% Hierarchy v Q@@
Table of Contents
EntityInstance B8 Flow Summary
&% MAX 10: 10MO45SAE144C8G B Flow Settings
[2b:c]
T EPT_10MD4_AF_52_Top & B Flow Non-Default Global Settings
B Flow Elapsed Time
B Flow os summary
E FlowLog
T =i Analysis & Synthesis
4 Fitter
Assembler
Tasks Compilation ~ | =1E®
Power Analyzer
Task = 3 Timing Analyzer
= P Complile Design r EDA Netlist Writer
* P Analysis & Synthesis O Flow Messages
O Flow Suppressed Messages
b P Fitter (Place & Route) PP =8
» P Assembler (Generate proerammine files) b
L » 4
® o &
Al D[ A4 N <<Filters> ®8Find.. | MBFind Next
~ Type i) Message
» Quartus Prime Timing Analyzer was successful. O errors, warnings

runnina Nuarrus prima £Fna Netlist writer

Page

> >

& Compilation Report - EPT_10M04_AF_S2_Top X

3o TR | o
® <<Filter>>

Flow Status

Quartus Prime Versio
Revision Name
Top-level Entity Nam
Family

Device

Timing Models

Total logic elements
Total registers
Total pins

Total virtual pins
Total memory bits
Embedded Multiplier
Total PLLs

UFM blocks

ADC hlacks

‘

@ © 4

IP Catalog

Dt 9

o

+ @ Installed P
* Project Directory

No Selection Available

~ Library

Basic Functions

DsP

Interface Protocols

Memory Interfaces and Controllers
Processors and Peripherals

University Program

@ search for Partner 1P

+ Add.
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The Programmer Window will open up with the programming file selected. Click on the

Hardware Setup button in the upper left corner.

0 Programmer - [Chain.cdf]

Eile Edit Wiew Processing Tools Window Help

; Hardware Setup... PT-JTAG-EBlaster v1.0 (64) [MBUSE-0] Mode: | JTAG

Enable real-time ISP to allow background programming when available

File Device Checksum Usercode Program/  Verify = Blank-
Configure Check

M auto Detect
Delete
" Add File
¢ Change File 1

A save File

* Add Device...
T

s Down

= Progress: l

Examine  Security Erase ®ac ISP 'SFi{PF
Bit acks CLAMP

The Hardware Setup Window will open. In the “Available hardware items”, double click on

“EPT-JTAG-Blaster v1.0b (64)”.
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Hardware Settings JTAG Settings

Select a programming hardware setup to use when programming devices. This programming

hardware setup applies only to the current programmer window.

Currently selected hardware: | EPT-JTAG-EBlaster v1.0 (64) [MBLUSE-0]

Hardware frequency:

Available hardware items

Har Server Port

EPT-JTAG-EBlaster v1.0 (64) )al MBEUSE-O

Hz

Add Hardware. .

Remove Hardware

Close

If you successfully double clicked, the “Currently selected hardware:” dropdown box will show

the “EPT-JTAG-Blaster v1.0b (64)”.
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- é Hardware Setup

Hardware Settings JTAG Settings

Select a programming hardware setup to use when programming devices. This programming

hardware setup applies only to the current programmer window.

Currently selected hardwa@-JTﬂG-Blaster v1.0 (64) [MBUSB-D -

Hardware frequency:

Available hardware items

Hardware

EPT-JTAG-Blaster v1.0 (64)

Click on the “Add File” button

Server

Local
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a Programmer - [Chainl.cdf] = O =

Eile Edit View Processing Tools Window Help

; Hardware Setup... | |EPT-JTAG-Blaster v1.0 (64) [MBUSB-0] Mode: | JTAG v Progress:

Enable real-time ISP to allow background programming when available

File Device Checksum Usercode Program/ = Verify = Blank- Examine | Security Erase Reac ISP 'S Fi{PF
Configure Check Bit :cks CLAMP
%S’.:p
»
* Add Device...
%I_\:
Y
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a Select New Programming File

Look in: C:\Users\nelso\Documents\EPT_10M04_AF_Blinky\EPT_10M04_AF_S52_Top - Q@ 0 ©
Z My Computer Name
nelso db

simulation

| File name: |

| Files of type: | Programming Files (*.sof *.pof * jam *.jbc *.ekp * jic)

@ E E

Open

Cancel

At the Browse window, double click on the output files folder.
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a Select New Programming File X
Look in: C:\Users\nelso\Documents\EPT_10M04_AF_Blinky\EPT_10M04_AF_52_Top\output_files v 0 © @ @ E]
Z My Computer Name
nelso | | EPT 10M04 AF 52 Top.pof
I [ | EPT_10M04_AF_52_Top.sof
| q [
| File name: Open
Files of type: | Programming Files (*.sof *.pof * jam *.jbc *.ekp * jic) v Cancel

Double click on the “EPT _10M04 AF S2 Top.sof” file. Click the Open button in the lower
right corner.
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é Pragrammer - Ci/Users/nelso/Documents/EPT_10MO4_AF_Blinky/EPT_10MO4_AF_S2_Top/EPT_10MO4_AF_S2_Top - EPT_10MO4_AF_S2_Top... = O x
Eile Edit View Processing Tools Window Help Search Intel FPGA e
:. Hardware Setup... | |[EPT-JTAG-Blaster v1.0 (64) [MBUSE-0] Mode: | JTAG b Progress: 100% (Successful)

Enable real-time ISP to allow background programming when available

Ny File Device Checksum Usercade Program/ = Verify = Blank- Examine  Security = Erase
- |
Configure Check Bit

i Stap output_files/EPT_10M... | 10MO4SAE144 0008DB62 0008DEG62

) Auto Detect
X Delete
[ | M add File..

%Change File..

b save File

, .Add Device... TDI =

W5 own

Next, selet the checkbox under the “Program/Configure” of the Programmer Tool.
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» Pragrammer - Ci/Users/nelso/Documents/EPT_10MO4_AF_Blinky/EPT_10MO4_AF_S2_Top/EPT_10MO4_AF_S2_Top - EPT_10MO4_AF_S2_Top... = O x
Eile Edit View Processing Tools Window Help Search Intel FPGA e.
:. Hardware Setup... | |[EPT-JTAG-Blaster v1.0 (64) [MBUSE-0] Mode: | JTAG b Progress: 100% (Successful) m

Enable real-time ISP to allow background programming when available

m File Device Checksum Usercade Program/ = Verify = Blank- Examine  Security = Erase
Pl start : i
Check Bit
i Stoj output_files/EPT_10M.. 10MO4SAE144 0008DEG2 000BDEG2
& Auto Detect
X Delete
" Add File...

%Change File..

b save File

: .Add Device... TDI u :'
| o
Bup —

I H a
%[:Cv‘.l" r_J.I.I.lIlJ.I.I._':

TPEMO4SAE14

Click on the Start button to to start programming the FPGA.
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» Pragrammer - Ci/Users/nelso/Documents/EPT_10MO4_AF_Blinky/EPT_10MO4_AF_S2_Top/EPT_10MO4_AF_S2_Top - EPT_10MO4_AF_S2_Top... = O x
Eile Edit View Processing Tools Window Help Search Intel FPGA e.
:. Hardware Setup... | |[EPT-JTAG-Blaster v1.0 (64) [MBUSE-0] Mode: | JTAG b Progress: 100% (Successful) m

Enable real-time ISP to allow background programming when available

pls File Device Checksum Usercade Program/ = Verify = Blank- Examine  Security = Erase
ST Configure Check Bit I
i Stoj output_files/EPT_10M.. 10MO4SAE144 0008DEG2 000BDEG2
& Auto Detect
X Delete
" Add File...

%Change File..

b save File

: .Add Device... TDI u :'
| o
Bup —

I H a
%[:Cv‘.l" r_J.I.I.lIlJ.I.I._':

TPEMO4SAE14

When the programming is complete, the Progress bar will indicate success.
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» Programmer - Ci/Users/nelso/Documents/EPT_TOMO4_AF_Blinky/EPT_10M04_AF_52_Top/EPT_10MO04_AF_S2 Top - EPT_10MO4_AF_S2_Top... = m] X
Eile Edit View Processing Tools Window Help Search Intel FPGA e
; [REl T == T W F P T- I TAG-Blaster v1.0 (64) [MBUSE-0] Mode: | JTAG v Progress: 100% (Successful)

Enable real-time ISP to allow background programming when available

File Device Checksum Usercode Program/ = Verify = Blank- Examine  Security Erase

i
Sl Configure Check Bit

i stop output_files/EPT_10M... 10MO4SAE144 D00SDE62  ODDBDEG2 v
M auto Detect
X Delete
™ add File..

[ Change File...

i) save File

® add Device... TDI

Whown

At this point, the MaxProLogic is programmed and ready for use.

The eight LEDs on the front of the MAXPROLOGIC will blink one after the other.
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